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3GPP FDD Base Station Transmitter Test

3GPPFDD_BS_TX is the test bench for 3GPP FDD base station transmitter testing. The test bench provides a way for
users to connect to an RF circuit device under test and determine its performance by activating various test bench
measurements. This test bench provides signal measurements for RF envelope, power (including CCDF), occupied
bandwidth, ACLR, code and peak code domain power, and EVM.

The signal and most of the measurements are designed according to the 3GPP Technical Specification TS 25.141 and
TS 25.104. Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal Generator, Option 400 (3GPP
W-CDMA Firmware Option for the E4438C ESG Vector Signal Generator). Details regarding Agilent E4438C ESG are

included at the website http://www.agilent.com/find/esg.

The DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF DUT connection, RF
receivers, and DSP measurement blocks, as illustrated in the following figure. The generated test signal is sent to the
DUT.

WTE RF WTE Meas
Q Output Input
Meas Signal DSP
TX | gl AF Modulator RF Output RF RF Load Meas RF | Measurement
DSP | g —= Resistance —#= DUT = Resistance Receiver
|

RF Receivel » RF Slgﬂﬁl DsP
. Measurement
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Transmitter Wireless Test Bench Block Diagram

In the 3GPP downlink signal frame structure, one frame has a duration of 10 msec and consists of 15 slots; each slot
contains 2560 chips; each chip is an RF signal symbol.

There is only one type of downlink dedicated physical channel, the downlink dedicated physical channel (downlink
DPCH). Within one downlink DPCH, dedicated data generated at Layer 2 and above (i.e. the dedicated transport
channel (DCH), is transmitted in time-multiplex with control information generated at Layer 1). Layer 1 control
information consists of known pilot bits to support channel estimation for coherent detection, transmit power-control
(TPC) commands, and an optional transport-format combination indicator (TFCI). The TFCI informs the receiver about
the instantaneous transport format combination of the transport channels mapped to the simultaneously transmitted
downlink DPCH radio frame.

The downlink DPCH can therefore be seen as a time multiplex of a downlink DPDCH (Datal and Data2) and a downlink
DPCCH (TPC, TFCI, and Pilot).

The frame and slot structure of the downlink DPCH is illustrated in the following figure. (The following tables provide
more information about each field.)

. DPDCH DPCCH > DPDCH DPCCH
Datal TR TECI Diata2 Pilot
My bits Nepe bits Mg bits M0 bits M bits

T = 2560 chips, 10°%2¥ bits (k=0..7)

Slot #20 | Blot#1 Slot # Slot #14

F 9

Cne radio frame, Ty=101ms >

3GPP FDD Downlink Frame and Slot Structure

DPCH Structure for Test Model 1 and Test Model 2
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Slot Channel Channel SF Bits/Slot DPDCH Bits/Slot DPCCH Bits/Slot
Format Bit Rate Symbol NDatal NData2 NTFCI NTPC Npilot
No. (kbps) Rate ata ata ptio
(kbps)
10 60 30 128 40 24 2
DPCH Structure for Test Model 3
Slot Channel Channel SF Bits/Slot DPDCH Bits/Slot DPCCH Bits/Slot
Format Bit Rate Symbol NDatal NData? NTFCI NTPC Noil
No. (kbps) Rate ata ata pilot
(kbps)
6 30 15 256 20 8 2

Test Bench Basics

A template is provided for this test bench.

i

IGPP FOD

Design Information

3GPPFDD_BS_TX_Info

R

Envelope

m YAR

ENVELOPE I

3GPPFDD Base Station Transmitter Test Bench

To access the template:

™S
L~

Amplifier?

3GPPFDD_BS_TX

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_BS_TX_test, click OK; click left to place the template in
the schematic window.
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An example design using this template is available; from the ADS Main window click File > Example Project >
WCDMA3G_RF_Verification_prj > 3GPPFDD_BS_TX_test .dsn.

The basics for using the test bench are:

e Connect to an RF DUT that is suitable for this test bench.

e CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values are typically accepted; if not,
set values based on your requirements.

e Activate/deactivate measurement(s) based on your requirements.

e Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.

Test Bench Details

The following sections provide details for setting up a test bench, setting measurement parameters for more control of
the test bench, simulation measurement displays, and baseline performance.

Open and use the template:

1. In an Analog/RF schematic window select Insert > Template .
2. In the Insert > Template dialog box, choose 3GPPFDD_BS_TX_test, click OK; click left to place the template in
the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is suitable for this test bench.
For information regarding using certain types of DUTs, see Appendix A, RF DUT Limitations.
2. Set the Required Parameters

© Note

Refer to 3GPPFDD_BS_TX for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the user as needed.

e Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data Flow simulation technology)
and the DUT (using Circuit Envelope simulation technology). Each technology requires its own simulation
time step with time-step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with this DUT. The CE_TimeStep
must be set to a value equal to or a submultiple of (less than) WTB_TimeStep; otherwise, simulation will
stop and an error message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other test bench parameter values;
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with default settings WTB_TimeStep=approx. 32.6 nsec. The value is displayed in the Data Display pages
as TimeStep.

WTB_TimeStep = 1/(ChipRate x SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during pulse forming.

e Set FSource, SourcePower, and FMeasurement.
° FSource defines the RF frequency for the signal input to the RF DUT.
° SourcePower defines the power level for FSource. SourcePower is defined as the average power during
the non-idle time of the signal.

° FMeasurement defines the RF frequency output from the DUT to be measured.
. Activate/deactivate ( YES / NO ) test bench measurements ( refer to 3GPPFDD BS TX ). At least one
measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters, Signal Parameters, and parameters
for each activated measurement. For details refer to Parameter Settings.
. The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench Block Diagram) uses FSource,
SourcePower ( Required Parameters ), MirrorSourceSpectrum ( Basic Parameters), GainImbalance,
PhaseImbalance, I OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the specified source resistance
(SourceR) and with power (SourcePower) delivered into a matched load of resistance SourceR. The RF signal has
additive Gaussian noise power set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT set by the MeasR value
(50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays associated with the RF DUT input
to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench Block Diagram) uses other
Signal Parameters.
More control of Circuit Envelope analysis can be achieved by setting Envelope controller parameters. These
settings include Enable Fast Cosim, which may speed the RF DUT simulation more than 10x. Setting these
simulation options is described in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
. To send the RF DUT output signal to an Agilent ESG RF signal generator, set parameters on the Signal to ESG

tab.
For details, refer to Signal to ESG Parameters.

. To run a simulation, choose Simulation > Run in the Analog Design Environment main window.

For details, refer to R unning a Simulation in the Wireless Test Bench Simulation documentation.
Simulation results will appear in a Data Display window for each measurement. Simulation Measurement
Displays describes results for each measurement.

For details on Viewing Results refer to the Wireless Test Bench Simulation documentation.
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3GPPFDD_BS_TX

This section provides parameter information for Required Parameters, Basic Parameters, Signal Parameters, and

parameters for the various measurements.

1 2

AGPP
0D et

3GFRFOD_BS_TH

Description 3GPP FDD BS TX test
Library WTB

Class TSDF3GPPFDD_BS_TX
Derived From baseWTB_TX

Parameters

Name Description Default Sym
RequiredParameters

CE_TimeStep Circuit 1/3.84 MHz/8
envelope
simulation
time step

WTB_TimeStep Set
CE_TimeStep
< =
1/3.84e6/SamplesPerChip.
SamplesPerChip
is in Signal
Parameters
tab.

FSource Source carrier 2140 MHz
frequency

SourcePower Source power | dbmtow(-20.0)

FMeasurement Measurement 2140 MHz
carrier

10

sec

Hz

Hz

Unit

real

real

real

real

Type

Range

(0, )

(0, )

[0, )
(0, )



frequency

MeasurementInfoAvailable
Measurements
Each
measurement
has
parameters on
its
tab/category
below.

RF_EnvelopeMeas&inane R
envelope
measurement?
NO, YES

PowerMeasurem dfrtable power
measurement?
NO, YES

ACLR_Measuremé&mable ACLR
measurement?
NO, YES

OccupiedBW_Medswablaent
occupied
bandwidth
measurement?
NO, YES

CDP_Measuremefhable code
domain power
measurement?
NO, YES

PCDE_Measureménible peak
code domain
error
measurement?
NO, YES

EVM_Measuremzhhable EVM
measurement?
NO, YES

BasicParameters

SourceR Source
resistance

SourceTemp Source
resistor
temperature

Advanced Design System 2008

YES

NO

NO

NO

NO

NO

NO

50 Ohm Ohm

-273.15 Celsius

11

enum

enum

enum

enum

enum

enum

enum

real

real

(0, )

[-273.15, )
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EnableSourceNcigmable source ' NO enum
thermal noise?
NO, YES

MeasR Measurement 50 Ohm Ohm real [10, 1.0e6]
resistance

MirrorSourceSpedditnor source NO enum
spectrum
about carrier?
NO, YES

MirrorMeasSpectidirror meas NO enum
spectrum
about carrier?
NO, YES

RF_MirrorFreq @ Mirror source NO enum
frequency for
spectrum/envelope
measurement?
NO, YES

MeasMirrorFreq Mirror meas NO enum
frequency for
spectrum/envelope
measurement?
NO, YES

DUT_DelayBoundUT delay 10.0 usec sec real [O,
bound (400.0/3840000)]

TestBenchSeed Random 1234567 int [0, )
number
generator
seed

SignalParameters

GainIlmbalance = Gain 0.0 dB real (-c0, )
imbalance, Q
vs 1

PhaseImbalance Phase 0.0 deg real (-c0, )
imbalance, Q
vs I

I_OriginOffset I origin offset 0.0 real (-c0, )
(percent)

Q_OriginOffset = Q origin offset | 0.0 real (-c0, )
(percent)

IQ_Rotation IQ rotation 0.0 deg real (-c0, )

12
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SamplesPerChip Samples per 8

chip

RRC_FilterLengthRRC filter 16

SpecVersion

SourceType

length (chips)

Secification Version 12_00

version:
Version
03_00,
Version
12_00,
Version 03_02

Source type: TestModel1l_16DPCHs

TestModell_16DPCHs,
TestModell_32DPCHs,
TestModell_64DPCHs,
TestModel2,

TestModel3_16DPCHs,
TestModel3_32DPCHs,
TestModel4

RF_EnvelopeMeasurementParameaters

RF_EnvelopeDispRiyRagetope

measurement
display pages:
3GPPFDD_BS_TX
Envelope

Figures

RF_EnvelopeStarRF envelope 0.0

measurement
start

RF_EnvelopeStopRF envelope (2560/3.84)

measurement  usec
stop

RF_EnvelopeSlotRF envelope 1

measurement
slots

PowerMeasurementParameters

PowerDisplayPag@swer

measurement
display pages:
3GPPFDD_BS_TX
Power Tables
3GPPFDD_BS_TX
Power Figures
3GPPFDD_BS_TX

13

int [2, 32]
int [1, o0)
enum
enum
sec real [0, )
sec real (0, o0)
int [0, 100]
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Power
Equations
PowerStartSlot = Start slot 0 int [0, )
PowerSlotsMeasu$éats 1 int [0, o)
measured

ACLR_MeasurementParameters

ACLR_DisplayPagk6LR
measurement
display pages:
3GPPFDD_BS_TX
ACLR Tables
3GPPFDD_BS_TX
ACLR Figures
3GPPFDD_BS_TX
ACLR
Equations

ACLR_Start Measurement | 0.0 sec real [0, o0)
start

ACLR_Stop Measurement @ (2560/3.84) sec real (0, )
stop usec

ACLR_Slots Measurement O int [0, 100]
slots

ACLR_SpecMeasRasitrum 0 Hz real [0, )
resolution
bandwidth

ACLR_SpecMeasWiitdbww type:  ACLR none enum
ACLR none,
ACLR
Hamming
0.54, ACLR
Hanning 0.50,
ACLR Gaussian
0.75, ACLR
Kaiser 7.865,
ACLR 8510
6.0, ACLR
Blackman,

ACLR
Blackman-Harris

OccupiedBW_MeasurementParameters

OBW_DisplayPag@scupied BW
measurement
display pages:

14
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3GPPFDD_BS_TX
OBW Tables
3GPPFDD_BS_TX
OBW Figures
3GPPFDD_BS_TX
OBW

Equations

OBW_Start Measurement 0.0 sec real [0, )
start

OBW_Stop Measurement @ (2560/3.84) sec real (0, )
stop usec

OBW_Slots Measurement O int [0, 100]
slots

OBW_SpecMeasResBitrum 0 Hz real [0, o)
resolution
bandwidth

OBW_SpecMeasWitiddew type:  OBW none enum
OBW none,
OoBW
Hamming
0.54, OBW
Hanning 0.50,
OBW Gaussian
0.75, OBW
Kaiser 7.865,
OBW 8510
6.0, OBW
Blackman,

OoBW
Blackman-Harris

CDP_MeasurementParameters

CDP_DisplayPacesDP
measurement
display pages:
3GPPFDD_BS_TX
CDP Figures

CDP_StartSlot = Start slot 0 int [0, o0)
PCDE_MeasurementParameters

PCDE_DisplayPzd&sDE
measurement
display pages:
3GPPFDD_BS_TX
PCDE Tables
3GPPFDD_BS_TX

15
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3GPPFDD_BS_TX

PCDE
Equations

PCDE_StartSlot Start slot

EVM_MeasuremezntParameters

EVM_DisplayPagesvVM

EVM_Start

measurement
display pages:

0

3GPPFDD_BS_TX

EVM Tables

3GPPFDD_BS_TX

EVM Equations

Measurement
start

EVM_SlotsMeasusdts

measured

SignalToESG_Pgrameters

EnableESG

Enable signal
to ESG? NO,
YES

ESG_Instrument ESG

ESG_Start
ESG_Stop

ESG_Slots
ESG_Power

ESG_CIkRef

instrument
address

Signal start

Signal stop

Slots to ESG

ESG RF ouput
power (dBm)

Waveform
clock
reference:
Internal,
External

ESG_ExtCIkRefFrégternal clock

ESG_IQFilter

reference freq

IQ filter:
through,
filter_2100kHz,
filter_40MHz

0.0

NO

sec

[GPIB0::19::INSTR][localhost][4790]

0

(2560/3.84)

usec
15
-20.0

Internal

10 MHz

through

sec

sec

Hz

16

int [0, )

real [0, )

int [1, o0)

enum

instrument

real [0, o0)

real [(ESG_Start+60/3.84e6
(ESG_Start+32/3.84/S)

int [0, 1000]

real (-00, )

enum

real (0, c0)

enum



ESG_SampleClkRaéguencer
sample clock
rate

ESG_Filename @ ESG waveform
storage
filename

ESG_AutoScalingActivate auto
scaling? NO,
YES

ESG_ArbOn Select
waveform and
turn ArbOn
after
download?
NO, YES

ESG_RFPowOn ' Turn RF ON
after
download?
NO, YES

ESG_EventMarkeEingmé marker
type: Neither,
Eventl,
Event2, Both

ESG_MarkerLengB$%G marker
length

Pin Inputs

Pin

2 Meas_In

Pin Outputs

Pin

1 RF_Out

Parameter Settings

Advanced Design System 2008

30.72 MHz Hz

3GPPFDD_DL

YES

YES

YES

Eventl

10

Name Description

Name Description

circuit

17

Test bench measurement
RF input from RF circuit

Test bench RF output to RF

real

string

enum

enum

enum

enum

int

timed

timed

(0, )

[1, 60]

Signal Type

Signal Type
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More control of the test bench can be achieved by setting parameters on the Basic Parameters, Signal Parameters,
and measurements categories for the activated measurements. Parameters for each category are described in the
following sections.

 Note

For required parameter information, see Set the Required Parameters.

Basic Parameters

N =

SourceR is the RF output source resistance.

. SourceTemp is the RF output source resistance temperature (oC) and sets noise density in the RF output signal

to (k(SourceTemp+273.15)) Watts/Hz, where k is Boltzmann's constant.

EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it to -273.150C (0 Kelvin).
When set to YES, the noise density due to SourceTemp is enabled.

MeasR defines the load resistance for the RF DUT output Meas signal into the test bench. This resistance loads
the RF DUT output; it is also the reference resistance for Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the generated RF signal before it is sent
to the RF DUT. Depending on the configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in RF signal input to the test
bench (and output from the RF DUT). Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and measurement of the RF DUT
output signal requires that its RF envelope is not mirrored compared to the signal generated by the signal source
(before any mirroring is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for measurements on the
Meas_in signal in TX test benches (EVM, Constellation, CDP, PCDE) and results in measurement on a signal with
no spectrum mirroring.

. TestBenchSeed is an integer used to seed the random number generator used with the test bench. This value is

used by all test bench random number generators, except those RF DUT components that use their own specific
seed parameter. TestBenchSeed initializes the random number generation. The same seed value produces the
same random results, thereby giving you predictable simulation results. To generate repeatable random output
from simulation to simulation, use any positive seed value. If you want the output to be truly random, enter the
seed value of 0.

RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal for RF envelope, ppectrum,
ACLR, and occupied bandwidth measurements. RF_MirrorFreq is typically set by the user to NO when
MirrorSourceSpectrum = NO; RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum =
YES. Both settings result in viewing the RF_out signal with no spectrum mirroring. Other settings by the user
result in RF_out signal for RF_Envelope and Spectrum measurements with spectrum mirroring.

MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF signal for the RF envelope,
spectrum, ACLR, and occupied bandwidth measurements.

MeasMirrorFreq is typically set to NO by the user when the combination of the MirrorSourceSpectrum value and
any signal mirroring in the users RF DUT results in no spectrum mirroring in the Meas_in signal. MeasMirrorFreq
is typically set to YES by the user when the combination of the MirrorSourceSpectrum and RF DUT results in
spectrum mirroring in the Meas_in signal.

Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements with spectrum mirroring.

18
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The MirrorMeasSpectrum parameter setting has no impact on the setting or use of the MeasMirrorFreq
parameter.

10. DUT_DelayBound is used to transfer the DUT delay to measurements synchronization. For measurements of
RF_out before the DUT, an RF delay bound is calculated by adding delays caused by RRC filters in modulation
and measurements. For measurements of RF DUT output (Meas_in), Meas delay bound is calculated by adding
DUT_DelayBound to RF delay bound.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are used to add certain
impairments to the ideal output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance applied. The RF is given by:

Verp(t) = A{V(t)cos(o t) -gV(t)sin| o t+ %|;|

where A is a scaling factor that depends on the SourcePower and SourceR parameters specified by the user, VI (
t ) is the in-phase RF envelope, V Q ( t ) is the quadrature phase RF envelope, g is the gain imbalance

Gainlmbalance

g = 10 20

and, ¢ (in degrees) is the phase imbalance.

Next, the signal V RF ( t) is rotated by IQ_Rotation degrees. The I_OriginOffset and Q_OriginOffset are then
applied to the rotated signal. Note that the amounts specified are percentages with respect to the output rms
voltage. The output rms voltage is given by sqrt(2 x SourceR x SourcePower).

2. SamplesPerChip is used to set the number of samples in a chip. The default value is set to 8 to display settings
according to the 3GPP standard. It can be set to a larger value for a simulation frequency bandwidth wider than
8 x 3.84 MHz. It can be set to a smaller value for faster simulation; however, this will result in lower signal
fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger than the signal bandwidth by a factor of 8
(e.g., simulation RF bandwidth = 8 x 3.84 MHz).

3. RRC_FilterLength is used to set root raised-cosine (RRC) filter length in number of chips. The default value is set
to 16 to transmit a 3GPP FDD downlink signal in time and frequency domains based on the 3GPP standard [4]. It
can be set to a smaller value for faster simulation times; however, this will result in lower signal fidelity. Better
Adjacent Channel Leakage Ratio (ACLR) can be obtained using a longer filter length. Increasing RRC_FilterLength
to 24 or 32 should result in a better ACLR. This may also correlate better to ACLR measurements when using
instruments from Agilent Technologies.

4. SpecVersion is used to specify the 3GPP specification versions (2000-03, 2000-12 and 2002-03).

5. SourceType is used to specify the type of baseband signal. This source can generate 7 types of baseband signals
[5]: TestModell_16DPCHs, TestModell_32DPCHs, TestModell_64DPCHs, TestModel2, TestModel3_16DPCHs,
TestModel3_32DPCHs, and TestModel4
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e Test Model 1 Active Channels lists the active channels of Test Model 1, which is used to test spectrum

emission mask, ACLR, spurious emissions, transmit intermodulation, and base station maximum output

power.

e Test Model 2 Active Channels lists the active channels in Test Model 2, which is used to test output power

dynamics.

e Test Model 3 Active Channels lists the active channels of Test Model 3, which is used to test peak code

domain error.
e Test Model 4 Active Channels lists the active channels of Test Model 4, which is used to test EVM.

Test Model 1 Active Channels

Type Number of Fraction of Power | Level Setting (dB) Channelization Timing Offset
Channels (%) Code (x256Tchip)
PCCPCH+SCH 1 10 -10 1 0
Primary CPICH 1 10 -10 0 0
PICH 1 1.6 -18 16 120
SCCPCH 1 1.6 -18 3 0
containing PCH
(SF=256)t
DPCH (SF=128) 16/32/64 76.8 total see [5] see [5] see [5]

T SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5].

Test Model 2 Active Channels

Type Number of Fraction of Power | Level Setting (dB)| Channelization Timing Offset
Channels (%) Code (x256Tchip )
PCCPCH+SCH 1 10 -10 1 0
Primary CPICH 1 10 -10 0 0
PICH 1 5 -13 16 120
S-CCPCH 1 5 -13 3 0
containing PCH
(SF=256)
DPCH (SF=128) 3 2x 10,1 x 50 2x-10,1x-3 24,72, 120 1,7,2

T SCCPCH containing PCH is not included in versions 2000-03 and +2000-12+[5]

Test Model 3 Active Channels

Type

Number of

Fraction of Power

Level Settings

Channelization

Timing Offset
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Channels (%) 16/32 (dB) 16/32 Code (x256Tchip)
PCCPCH+SCH 1 12.6/7.9 -9/-11 1 0
Primary CPICH 1 12.6/7.9 -9/-11 0 0
PICH 1 5/1.6 -13/-18 16 120
SCCPCH 1 5/1.6 -13/-18 3 0
containing PCH
(SF=256) t
DPCH (SF=256) 16/32 63,7/80,4 total see Reference [5] | see Reference [5] | see Reference [5]

T SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5]

Test Model 4 Active Channels

Type Number of Fraction of Power Level Settings Channelization Timing Offset
Channels (%) 16/32 (dB) 16/32 Code (x256Tchip)
PCCPCH+SCH 1 50to 1.6 -3to -18 1 0
when Primary
CPICH is disabled
PCCPCH+SCH 1 25t0 0.8 -6 to -21 1 0
when Primary
CPICH is enabled
Primary CPICHT 1 25t0 0.8 -6 to -21 0 0

T Primary CPICH is optional; it is not included in versions 2000-03 and 2000-12 [5]

RF Envelope Measurement Parameters

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply spectrum mirroring to the
measured RF_out signal, set RF_MirrorFreq = YES. To apply spectrum mirroring to the measured Meas_in signal, set
MeasMirrorFreq = YES.

1. RF_EnvelopeDisplayPages provides Data Display page information for this measurement. It cannot be changed

by the user.

2. RF_EnvelopeStart sets the start time for collecting input data.

w

RF_EnvelopeStop sets the stop time for collecting input data when RF_EnvelopeSlots = 0.

4. RF_EnvelopeSlots (when > 0) sets the number of slots over which data will be collected.

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and RF_EnvelopeSlots, the stop time may be
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adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:

Start = TimeStep x (int(RF_EnvelopeStart/TimeStep) + 0.5)

Stop = TimeStep x (int(RF_EnvelopeStop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step intervals.

RF_EnvelopeSlots Resultant Stop Time
0 Stop
>0 Start + RF_EnvelopeSlots x SlotTime

For the RF envelope of Meas_in to contain at least one complete slot, the Stop value should be set to a minimum of
SlotTime + (RF DUT time delay).

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

Power Measurement Parameters

1. PowerDisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

2. PowerStartSlot sets the number of slots which should be ignored.

3. PowerSlotsMeasured sets the number of slots over which data will be collected.

The measurement start time is PowerStartSlot x SlotTime. The measurement stop time is (PowerStartSlot +
PowerSlotsMeasured) x SlotTime. SlotTime is defined in Test Bench Variables for Data Displays.

ACLR Measurement Parameters

The ACLR measurement is implemented by the spectrum measurement, which measures the RF signal spectrum in
different frequency offsets. The ACLR can be calculated by analyzing the spectrum measurement in the data display
file.

In the following, TimeStep denotes the simulation time step, and FMeasurement denotes the measured RF signal
characterization frequency.

1. The measurement outputs the complex amplitude voltage values at the frequencies of the spectral tones. It does
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not output power at frequencies of the spectral tones. However, one can calculate and display the power
spectrum as well as the magnitude and phase spectrum by using the dBm, mag, and phase functions of the data
display window.

Note that the dBm function assumes a 50-ohm reference resistance; if a different measurement was used in the
test bench, its value can be specified as a second argument to the dBm function, for example, dBm(SpecMeas,
Meas_RefR) where SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the resistive
load used.

By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz to FMeasurement +
1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the default spectrum extends to negative frequencies.
The spectral content at these negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed on the positive frequency
axis as would happen in an RF spectrum analyzer measurement instrument. This process may introduce an error
in the displayed frequency for the mirrored tones. The absolute error introduced is less than (spectrum frequency
step) / 2 (see the following table for the definition of spectrum frequency step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z transform. The algorithm can use
multiple slots and average the results to achieve video averaging (see note 6).

ACLR_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

ACLR_Start sets the start time for collecting input data.

ACLR_Stop sets the stop time for collecting input data when ACLR_Slots = 0 and ACLR_SpecMeasResBW = 0.
ACLR_Slots (when > 0) sets the number of slots over which data will be collected.

ACLR_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum measurement.

Depending on the values of ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW, the stop time may be adjusted
and/or spectrum video averaging may occur. The different cases are explained in the following table.

Referring to the following table let:

N

ouhAWw

Start = TimeStep x int((ACLR_Start/TimeStep) + 0.5)

Stop = TimeStep x int((ACLR_Stop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer number of time step intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular filter. It is the equivalent
width of a rectangular filter that passes the same amount of white noise as the window. The normalized ENBW is
the ENBW multiplied by the time duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window options available.

The Start and Stop times are used for both the RF_out and Meas_in signal spectrum analyses. The Meas_in
signal is delayed in time from the RF_out signal by the value of the RF DUT time delay. Thus for RF DUT time
delay > 0, the RF_out and Meas_in signal are inherently different and some spectrum display difference in the
two is expected.

TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

Effect of Different Values for ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW

Case 1 ACLR_Slots = 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
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Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

ACLR_Slots > 0 ACLR_SpecMeasResBW = 0

Resultant stop time = Start + ACLR_Slots x SlotTime
Notes: For ACLR_Slots > 0 and ACLR_SpecMeasResBW =
0

Video averaging occurs over all slot time intervals
Resultant resolution BW = X/SlotTime

Resultant spectrum frequency step = 1/SlotTime

Video averaging status = Yes, when ACLR_Slots > 1

ACLR_Slots = OACLR_Slots = 0
ACLR_SpecMeasResBW > 0

Resultant stop time = Start + N*SlotTimelnterval
where

N = int((Stop -Start)/SlotTimelnterval) + 1

For ACLR_Slots = 0 and ACLR_SpecMeasResBW > 0
Define SlotTimelnterval = TimeStep *
int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)

This means SlotTimelnterval is forced to a value that is
an integer number of time step intervals.

(Stop-Start) time is forced to be an integer number (N)
of SlotTimelnterval

N has a minimum value of 1

Video averaging occurs over all SlotTimelnterval

The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
ACLR_SpecMeasResBW but may not be exactly the same
if X/(ACLR_SpecMeasResBW*TimeStep) is not an exact
integer.

Resultant resolution BW = ResBW

Resultant spectrum frequency step = ResBW

Video averaging status = Yes when N > 1

ACLR_Slots > 0

ACLR_SpecMeasResBW > 0

Resultant stop time = Start + M*SlotTimelnterval
where

M = int((ACLR_Slots x SlotTime)/SlotTimelnterval) + 1
For ACLR_Slots > 0 and ACLR_SpecMeasResBW > 0
Define SlotTimelnterval = TimeStep *
int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimelnterval is forced to a value that is
an integer number of time step intervals.

(Stop-Start) time is forced to be an integer number (M)
of the SlotTimelnterval

M has a minimum value of 1

Video averaging occurs over all SlotTimelntervals

The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
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ACLR_SpecMeasResBW but may not be exactly the same
if X/(ACLR_SpecMeasResBW*TimeStep) is not an exact
integer.

Resultant resolution BW = ResBW

Resultant spectrum frequency step = ResBW

Video averaging status = Yes, when M > 1

7. ACLR_SpecMeasWindow specifies the window that will be applied to each slot before its spectrum is calculated.
Different windows have different properties, affect the resolution bandwidth achieved, and affect spectral shape.
Windowing is often necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral
distortion due to discontinuous or non-harmonic signal over the measurement time interval. Without windowing,
the estimated spectrum may suffer from spectral leakage that can cause misleading measurements or masking
of weak signal spectral detail by spurious artifacts.

The windowing of a signal in time has the effect of changing its power. The spectrum measurement compensates
for this and the spectrum is normalized so that the power contained in it is the same as the power of the input
signal.
Window Type Definitions:

e none

wl;kT:] — | 1.0 UE.‘?"_:ﬁI.T
0.0 otherwise

where N is the window size
¢ Hamming 0.54

2k

(kT = | 054-046c05( %) 0<h<N
0.0 otherwise
where N is the window size
e Hanning 0.50
(kT = | 05-05cos( %) 0<h<N
0.0 otherwise
where N is the window size
e Gaussian 0.75
var = | (50 osp-F<F
0.0 otherwise

where N is the window size
e Kaiser 7.865
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I 112
‘ IDL?_StiS[l—Lk ““J] )
wkT) = @ - 0<k<N
s T,(7.865)

0.0 otherwise

where N is the window size, a = N/ 2, and I 0 (.) is the Oth order modified Bessel function of the first kind
e 8510 6.0 (Kaiser 6.0)

Iu[a_u[l_[“f‘;“fﬁ] B
w(kT,) = ___— - " 0<k<N
I|:||._|§|.DI

0.0 otherwise

where N is the window size, a =N/ 2, and I 0 (.) is the Oth order modified Bessel function of the first kind
e Blackman

wkT ) = ‘ 042 DSan hk|+ousmuL4:f | 0<k<N
0.0 otherwise
where N is the window size
e Blackman-Harris
wkT) = ‘ 0.35875 - 0_43329.:93[3f +0.14128 cos L“i:ff | D_Ulmsm[f’;fj 0<k<N
0.0 otherwise
where N is the window size.
Window Options and Normalized Equivalent Noise Bandwidth
Window and Default Constant NENBW
none 1
Hamming 0.54 1.363
Hanning 0.50 1.5
Gaussian 0.75 1.883
Kaiser 7.865 1.653
8510 6.0 1.467
Blackman 1.727
Blackman-Harris 2.021
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OBW Measurement Parameters

The occupied bandwidth measurement is implemented by the spectrum measurement which measures the spectrum
of the input signal. The occupied bandwidth is calculated by analyzing the spectrum measured in data display files.

In the following notes, TimeStep denotes the simulation time step, and FMeasurement denotes the measured RF
signal characterization frequency.

1.

2.

ouAW

OBW_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

The measurement outputs the complex amplitude voltage values at spectral tone frequencies.

Spectral tone frequency power is not output; however, power, magnitude, and phase spectrums can be
calculated and displayed by using the dBm, mag, and phase functions of the data display window. Note that the
dBm function assumes a 50-ohm measurement reference resistance; if a different measurement is used in the
test bench, its value can be specified as a second argument to the dBm function; for example, dBm(SpecMeas,
Meas_RefR), where SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the resistive
load.

By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz to FMeasurement +
1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the default spectrum extends to negative frequencies.
The spectral content at these negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed on the positive frequency
axis as would happen in an RF spectrum analyzer measurement instrument. This process may introduce an error
in the displayed frequency for the mirrored tones. The absolute error introduced is less than (spectrum frequency
step) / 2 (see the following table for the definition of spectrum frequency step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z transform. The algorithm can use
multiple slots and average the results to achieve video averaging (see note 6).

OBW_Start sets the start time for collecting input data.

OBW_Stop sets the stop time for collecting input data when OBW_Slots = 0 and OBW_SpecMeasResBW = 0.
OBW_Slots (when > 0) sets the number of slots over which data will be collected.

OBW_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum measurement.

Depending on the values of OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW, the stop time may be adjusted
and/or spectrum video averaging may occur. The different cases are explained in the following table.

Let:

Start = TimeStep x int((OBW_Start/TimeStep) + 0.5)

Stop = TimeStep x int((OBW_Stop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer number of time step intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular filter. It is the equivalent
width of a rectangular filter that passes the same amount of white noise as the window. The normalized ENBW is
the ENBW multiplied by the time duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window options.

The Start and Stop times are used for both the RF_out and Meas_in signal spectrum analyses. The Meas_in
signal is delayed in time from the RF_out signal by the value of the RF DUT time delay. Thus for RF DUT time
delay > 0, the RF_out and Meas_.in signal are inherently different and some spectrum display difference in the
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two is expected.
TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

Effect of Different Values for OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW

Case 1 OBW _Slots = 0
OBW_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case 2 OBW_Slots > 0
OBW_SpecMeasResBW = 0
Resultant stop time = Start + OBW_Slots x SlotTime
For OBW_Slots > 0 and OBW_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals
Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when OBW_Slots > 1

Case 3 OBW_Slots = 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimelnterval
where
N = int((Stop -Start)/SlotTimelnterval) + 1
For OBW_Slots = 0 and OBW_SpecMeasResBW > 0
Define SlotTimelnterval = TimeStep *
int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimelnterval is forced to a value that is
an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (N)
of SlotTimelnterval
N has a minimum value of 1
Video averaging occurs over all SlotTimelnterval
The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the same
if X/(OBW_SpecMeasResBW*TimeStep) is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case 4 OBW_Slots > 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimelnterval
where
M = int((OBW_Slots x SlotTime)/SlotTimelnterval) + 1
For OBW_Slots > 0 and OBW_SpecMeasResBW > 0
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Define SlotTimelnterval = TimeStep *
int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)

This means SlotTimelnterval is forced to a value that is
an integer number of time step intervals.

(Stop-Start) time is forced to be an integer number (M)
of the SlotTimelnterval

M has a minimum value of 1

Video averaging occurs over all SlotTimelnterval

The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the same
if X/(OBW_SpecMeasResBW*TimeStep) is not an exact
integer.

Resultant resolution BW = ResBW

Resultant spectrum frequency step = ResBW

Video averaging status = Yes, when M > 1

7. OBW_SpecMeasWindow sets the window that can be used. Different windows have different properties, affect the
resolution bandwidth achieved, and affect spectral shape. The OBW_SpecMeasWindow is used to define the
window that will be applied to each slot before its spectrum is calculated. Windowing is often necessary in
transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral distortion due to discontinuous or
non-harmonic signal over the measurement time interval. Without windowing, the estimated spectrum may
suffer from spectral leakage that can cause misleading measurements or masking of weak signal spectral detail
by spurious artifacts.

The windowing of a signal in time has the effect of changing its power. The spectrum measurement compensates
for this and the spectrum is normalized so that the power contained in it is the same as the power of the input

signal.
Window Type Definitions:
* none
k<N
wkT ) = | 10 0<k<N

0.0  otherwise

where N is the window size
e Hamming 0.54

wukT - ‘ 0.54 —0.46cos

L¥ | 0<k<N
0.0 otherwise
where N is the window size
e Hanning 0.50
w(hT,) = ‘ 0.5- DSCMLF’;‘J 0<k<N
0.0 otherwise

where N is the window size
e Gaussian 0.75

29



Advanced Design System 2008

J-h"r /I /I

0.0 otherwise

a

| Y kk_ﬁn\ N
o) = | exp( 5075 =5 ‘k_;‘{_

where N is the window size
Kaiser 7.865

wkT) = - ' p<k<N
s I,(7.865)

0.0 otherwise

‘ ID[?_StiS[l _[;%‘J ]mﬁ

where N is the window size, a =N/ 2, and 10 (.) is the Oth order modified Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

I 172

IDLﬁ_D[l _L‘%‘J ] ]

w(kT,) = - ' 0<k=N
Iclkt].D_l

0.0 otherw ise

where N is the window size, a = N/ 2, and I 0 (.) is the Oth order modified Bessel function of the first kind
Blackman

w(kT ) = ‘ 0.42-0. 5muL hk|+onsmu[4:ff | 0<k<N
0.0 otherwise
where N is the window size
Blackman-Harris
wkT) ‘ 0.35875-0 —188"9-:9qu:;? +0. 141’*scouL4:ff | - 0. mmsm,f’:f’ | 0<k<N
0.0 otherwise
where N is the window size.
Window Options and Normalized Equivalent Noise Bandwidth
Window and Default Constant NENBW
1
Hamming 0.54 1.363
Hanning 0.50 1.5
Gaussian 0.75 1.883
Kaiser 7.865 1.653
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8510 6.0 1.467
Blackman 1.727
Blackman-Harris 2.021

CDP Measurement Parameters

CDP_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

CDP_StartSlot sets starting slot from which data will be collected. CDP_StartSlot is used for RF_out and Meas_in
CDP analyses.

The measurement interval is one timeslot. The length of time that data will be collected is SlotTime (Test Bench
Equations Derived from Test Bench Parameters and Exported to Data Display describes SlotTime).

PCDE Measurement Parameters

PCDE_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

PCDE_StartSlot sets the starting slot from which data will be collected. PCDE_StartSlot is used for RF_out and
Meas_in PCDE analyses.

The measurement interval is one timeslot. The length of time that data will be collected is SlotTime (Test Bench
Equations Derived from Test Bench Parameters and Exported to Data Display describes SlotTime).

EVM Measurement Parameters

1.

2.

EVM_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

EVM_Start specifies starting time instant for the measurement. EVM_Start time is used for RF_out and Meas_in
EVM analyses. The Meas_in signal is delayed in time from the RF_out signal by the RF DUT time delay value.
Thus for RF DUT time delay >0, RF_out and Meas_in signals are inherently different and some EVM difference in
the two is expected even if the RF DUT does not introduce any distortion other than time delay.
EVM_SlotsMeasured specifies the measurement interval. The time length of data to be collected is

EVM_SlotMeasuredx SlotTime (Test Bench Equations Derived from Test Bench Parameters and Exported to Data
Display describes SlotTime).
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Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an Agilent E4438C Vector Signal
Generator. This measurement uses Connection Manager architecture to communicate with the instrument; parameters
specify how data is interpreted.

Prerequisites for using the Signal to ESG option are:

e ESG Vector Signal Generator E4438C; for information, visit the web site

["http://www.agilent.com/find/esg"http://www.agilent.com/find/esg].

e PC workstation running an instance of the connection manager server.
e Supported method of connecting the instrument to your computer through the Connection Manager architecture;

for information, see Connection Manager.

Parameter Information

®

10.

11.

12.

. EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO, no attempt will be made to

communicate with the instrument.

ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument to be used in the
simulation, the connection manager server hosthame (defaults to localhost ), and the port at which the
connection manager server listens for incoming requests (defaults to 4790). To ensure that this field is populated
correctly, click Select Instrument, enter the server hostname and port, click OK to see the Remote Instrument
Explorer dialog, select a VSA resource identifier, and click OK. For details about selecting instruments, see
Instrument Discovery in the Wireless Test Bench Simulation documentation.

ESG_Start and ESG_Stop (when ESG_Slots=0) specify when to start and stop data collection. The number of
samples collected, ESG_Stop - ESG_Start + 1, must be in the range 60 samples to 64 Msamples, where 1
Msample = 1,048,576 samples. The ESG requires an even number of samples; the last sample will be discarded
if ESG_Stop - ESG_Start + 1 is odd.

ESG_Slots sets the number of slots over which data will be collected. When ESG_Slots > 0, ESG_Stop is forced
to ESG_Start + ESG_Slots x SlotTime (where SlotTime is 5 msec).

ESG_CIkRef specifies an internal or external reference for the ESG clock generator. If set to External, the
ESG_ExtClkRefFreq parameter sets the frequency of this clock.

ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies between the DAC output and the
Dual Arbitrary Waveform Generator output inside the ESG.

ESG_SampleClkRate sets the sample clock rate for the DAC output.

ESG_FileName sets the name of the waveform inside the ESG that will hold the downloaded data.

. The ESG driver expects data in the range {-1, 1}. ESG_AutoScaling specifies whether to scale inputs to fit this

range. If set to YES, inputs are scaled to the range {-1, 1}; if set to NO, raw simulation data is downloaded to
the ESG without any scaling, but data outside the range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also
applied to data written to the local file (ESG_FileName setting).

If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after simulation data is
downloaded; if set to NO, waveform generation must be turned on at the ESG front panel.

If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after simulation data is downloaded.
If ESG_RFPowOn is set to NO (default), RF power must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Eventl, Event2, Both, or Neither. Event
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markers are used for synchronizing other instruments to the ESG. When one or both EventMarkers are enabled,
Eventl and/or Event2 is set beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting the corresponding event from
the front panel of the ESG.

ESG_MarkerLength specifies the range of points over which the markers must be set starting from the first point
of the waveform. Depending on the setting of ESG_EventMarkerType, the length of trigger Eventl or Event2 (or
both) is set to a multiple of the pulsewidth that, in turn, is determined by the sample clock rate of the DAC
output.

Simulation Measurement Displays

After running the simulation, results are displayed in the Data Display pages for each measurement activated.

Li]

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display

Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless Test
Benches.

RF Envelope Measurement

The RF Envelope measurement (not defined in 3GPP specifications) measures the RF signal at the input of the RF DUT,
and the Meas signal at the output of the RF DUT. Test Model 4 is used. The following figure shows the results.

The DUT delay (also displayed) is calculated by comparing the markers on the waveforms of RF_out (before DUT) and
Meas_in (after DUT).
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RF Envelope Measurement Results

Power Measurement

The power measurement (not defined in 3GPP specifications) shows transmitter CCDF curves. The CCDF and
peak-to-average ratio of RF_out signal before the DUT and the Meas_in signal after the DUT are measured.

Test Model 1 is used. The following figure shows the mean power, peak power and peak-to-mean ratio of the signals.
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CCDF Curves

ACLR Measurement

The adjacent channel leakage power ratio (ACLR) measurement is defined in 3GPP TS 25.104, section 6.6.2.2. Test
Model 1 is used.
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ACLR is the ratio of the transmitted power to the power measured in an adjacent channel. Both the transmitted and
the adjacent channel power are measured through a matched filter (root raised cosine and roll-off 0.22) with a noise

power bandwidth equal to the chip rate. The ACLR of the RF_out signal before the DUT and Meas_.in signal after the
DUT are measured.

The ACLR must be higher than the value specified in the following table.

Base Station ACLR

Base Station Adjacent Channel Offset t ACLR Limit

5 MHz 45 dB

10 MHz 50 dB

T Offset below the first or above the last carrier frequency used.

The following figure shows the power of adjacent channels and the ACLR. Test results and requirements are also
shown.
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If the adjacert channel powwer is greater than -50dBm
then the ACLR shall be higher than the above value

ACLR Measurement Results

Test Fesults

Passed

The following figure shows the spectrums of the main and the adjacent channels.
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ACLR Spectrums

Occupied Bandwidth Measurement

The occupied bandwidth (OBW) measurement is defined in 3GPP TS 25.104, section 6.6.1. OBW is a measure of the
bandwidth containing 99% of the total integrated power for transmitted spectrum and is centered on the assigned
channel frequency. The occupied channel bandwidth must be less than 5 MHz based on a chip rate of 3.84 Mcps.

The OBW of RF_out signal before the DUT and the Meas_in signal after the DUT is measured. Test Model 1 is used.
The following figure shows the signal spectrums. The markers are moved so that the higher and lower percentages of
the spectrum add up to 1% of the total power.
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Occupied Bandwidth Signal Spectrums

The following figure shows the resolution bandwidth and the occupied bandwidth of the signals.
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3GPP Specification TS 25.104 V4 4.0 section 6.6.1

Specification requirements

Test results

The occupied channel bandwidth zhall be lezz than SMHz baze on a chip rate of 3.54 Mops.

(Section 661 of TS 25104 v4.4.00

Occupied Bandwidth Measurement Results

CDP Measurement

Passeil

The code domain power (CDP) measurement (not defined in 3GPP specifications) is a measure of power distribution on
code domain. CDP is calculated by projecting the power onto the code domain at a specified spread factor (256). The
CDP for every code in the domain is defined as the ratio of the mean power of the projection onto that code, to the
mean power of the composite reference waveform. The measurement interval is one timeslot. Test Model 3 is used.

The following figure shows the CDP before and after the DUT.
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CDP Measurement Results

PCDE Measurement

This peak code domain error (PCDE) measurement is defined in 3GPP TS 25.104, section 6.8.3. PCDE is calculated by
projecting the power of the error vector onto the code domain at a specified spread factor. The code domain error for
every code in the domain is defined as the ratio of the mean power of the projection onto that code, to the mean
power of the composite reference waveform. This ratio is expressed in dB. The PCDE is defined as the maximum value
for the code domain error for all codes. The measurement interval is one timeslot. At a spreading factor of 256, the
PCDE must not exceed -33dB.

Test Model 3 is used. The following figure shows the PCDE figures before and after the DUT. Markers mark the peak
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error and the codes.
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PCDE Waveforms

The following figure shows the PCDE table. The result is also displayed according to the specification.
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The peak code domain emor shall not excesd -33 dB

PCDE Measurement Results

EVM Measurement

This error vector magnitude (EVM) measurement is defined in 3GPP TS 25.104, section 6.8.2. EVM is a measure of the
difference between the theoretical waveform and a modified version of the measured waveform. This difference is
called the error vector. The measured waveform is modified by first passing it through a matched root raised-cosine
filter with a bandwidth of 3.84MHz and 0.22 roll-off. The waveform is then further modified by selecting the frequency,
absolute phase, absolute amplitude, and chip clock timing so as to minimize the error vector. The EVM result is

defined as the root of the mean error vector power to the mean reference signal power expressed as a percent. The
EVM cannot exceed 17.5%.

Test Model 4 is used for this measurement.

The following figure shows the results of the EVM before and after the DUT.
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EVM Measurement Results

Test Bench Variables for Data Displays

Reference variables used to set up this test bench are listed in the following tables.

Test Bench Constants for Base Station Signal Setup

Constant Value
SamplesPerChip 8
ChipRate 3.84 MHz
ChipsPerSlot 2560
SlotsPerFrame 15

SourceType Determines Type of Source

SourceType Type of Source
TestModel 16DPCHs Test Model 1 with 16 DPCHs (Test Model 1 Active
Channels)
TestModel_32DPCHs Test Model 1 with 32 DPCHs (Test Model 1 Active
Channels)
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TestModel_64DPCHs Test Model 1 with 64 DPCHs (Test Model 1 Active
Channels)

TestMode2 Test Model 2 (Test Model 2 Active Channels)

TestMode3_16DPCHs Test Model 3 with 16 DPCHs (Test Model 3 Active
Channels)

TestMode3 32DPCHs Test Model 2 with 16 DPCHs (Test Model 3 Active
Channels)

TestMode4 Test Model 4 (Test Model 4 Active Channels)

Test Bench Equations Derived from Test Bench Parameters and Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters
RF_FSource FSource
RF_Power_dBm 10*log10(SourcePower)+30
RF_R SourceR
TimeStep 1/(ChipRate*SamplesPerChip)
This is the test bench simulation time step
SlotTime ChipsPerSlot*SamplesPerChip*TimeStep
This is the time duration of each slot
FrameTime SlotTime*SlotsPerFrame
Meas_FMeasurement FMeasurement
Meas_R MeasR

Baseline Performance

e Test Computer Configuration
° Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
¢ Conditions
° Measurements made with default test bench settings.
° RF DUT is an RF system behavior component.
° The number of time points in one slot can be calculated by SamplesPerChip times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
° Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 p time points per slot = 20480
e Simulation times and memory requirements.

Measurement Slots Measured Simulation Time (sec) ADS Processes (MB)
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RF_Envelope 1 10.5 183
Power 1 5 179
ACLR 1 82 215
Occupied BW 1 11 186
CDP 1 206 179
PCDE 1 450 179
EVM 1 450 179

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and the RF DUT Circuit Envelope
simulation with the same signal and number of time points. For example, if the RF DUT performance with Circuit
Envelope simulation alone takes 2 hours and consumes 200 MB of memory (excluding the memory consumed by the
core ADS product), then add these numbers to the Baseline Performance numbers to determine the expected ADS
performance. This is valid only if the full memory consumed is from RAM. If RAM is less, larger simulation times may
result due to increased disk access time for swap memory usage.

References

1. 3GPP Technical Specification TS 25.211, "Physical channels and mapping of transport channels onto physical
channels (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25211-3a0.zip

2. 3GPP Technical Specification TS 25.212, "Multiplexing and Channel Coding (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25212-390.zip

3. 3GPP Technical Specification TS 25.213, "Spreading and modulation (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25213-370.zi

4. 3GPP Technical Specification TS 25.104, "UTRA (BS) FDD; Radio transmission and Reception" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25104-3a0.zi

5. 3GPP Technical Specification TS 25.141, "Base station conformance testing (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25141-390.zi

Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation documentation explains how to use
test bench windows and dialogs to perform analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation documentation explains how to set
up circuit envelope analysis parameters such as convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench Simulation documentation to learn how
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to improve simulation speed.

3GPP FDD User Equipment Transmitter Test

3GPPFDD_UE_TX is the test bench for 3GPP FDD user equipment transmitter testing. The test bench provides a way
for users to connect to an RF circuit device under test and determine its performance by activating various test bench
measurements. This test bench provides signal measurements for RF envelope, power (including CCDF), occupied
bandwidth, adjacent channel leakage power ratio, adjacent channel leakage power ratio due to switching transients,
code and peak code domain power, and EVM.

The signal and most of the measurements are designed according to the 3GPP Technical Specification TS 25.101 and
TS 34.121. Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal Generator, Option 400 (3GPP
W-CDMA Firmware Option for the E4438C ESG Vector Signal Generator). Details regarding Agilent E4438C ESG are

included at the website http://www.agilent.com/find/esg.

The DUT output signal can be sent to an Agilent ESG RF signhal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF DUT connection, RF
receivers, and DSP measurement blocks, as illustrated in the following figure. The generated test signal is sent to the
DUT.

WTE RF WTE Meas
Q Output Input
Meas Signal DSP
TX | g AF Modulator RF Output RF RF Load Meas RF o] Measurement
DSP | ! —= Resistance —# DUT = Resistance Receiver
|

RF Receiver . RF Signal DSP
e Measurement

Transmitter Wireless Test Bench Block Diagram

In the 3GPP uplink signal frame structure, one frame has a duration of 10 msec and consists of 15 slots. Each slot
corresponds to one power control period and contains 2560 chips.
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There are two types of uplink dedicated physical channels - uplink dedicated physical data channel (uplink DPDCH)
and uplink dedicated physical control channel (uplink DPCCH). These channels are I/Q code multiplexed within each
radio frame.

Uplink DPDCH is used to carry the DCH transport channel. There may be zero, one, or several uplink DPDCHs on each
radio link.

Uplink DPCCH is used to carry control information generated at Layer 1. Layer 1 control information consists of known
pilot bits to support channel estimation for coherent detection, transmit power-control (TPC) commands, feedback
information (FBI), and an optional transport-format combination indicator (TFCI). The TFCI informs the receiver about
the instantaneous transport format combination of the transport channels mapped to the simultaneously transmitted
uplink DPDCH radio frame. There is only one uplink DPCCH on each radio link.

The frame structure of the uplink dedicated physical channels is illustrated in the following figure. The following 4
tables provide more information about each field.

Drata
DPDCH N, bits

»
L J

T, = 2560 chips, Ny, = 10*2* buts (k=0..6)

Filot TFCI FEI TRC

DPCCH M_ g bits N bits Mgg; bits N g hits

-
L J

T4, = 2560 chups, 10 bats

Slot#0 | Slot#l Slot# Slot #14

1 radio frame: T;= 10 ms

-~

I

12.2 kbps Uplink Channel Frame Structure
Uplink 12.2 kbps Reference Measurement Channel, DPDCH Fields
Channel Bit Rate = Channel Symbol SF Bits / Frame Bits / Slot Ndata

(kbps) Rate (ksps)
60 60 64 600 40 40
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Uplink 12.2 kbps Reference Measurement Channel, DPCCH Fields

Channel Channel SF Bits / Bits / Slot Npilot NTPC NTFCI NFBI

Bit Rate Symbol Frame

(kbps) Rate

(ksps)
15 15 256 150 10 6 2 2 0
Uplink 768 kbps Reference Measurement Channel, Transport Channel Parameters
Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 3840 100
Transport Block Set Size 7680 100
Transmission Time Interval 10 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
Uplink 768 kbps Reference Measurement Channel, DPDCH Fieldst
Channel Bit Rate | Channel Symbol SF Bits / Frame Bits / Slot Ndata
(kbps) Rate (ksps)

960 960 4 9600 640 640

T There are two DPDCHs in uplink 768 kbps RMC.

Test Bench Basics

A template is provided for this test bench.
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AGPP FDD
Design Information
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3GPPFDD_UE T Info
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Envelope
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VAR iy
3GPPFDD_UE_TH

3GPPFDD User Equipment Transmitter Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_UE_TX_test, click OK; click left to place the template in
the schematic window.

An example design using this template is available; from the ADS Main window click File > Example Project >
WCDMA3G_RF_Verification_prj > 3GPPFDD_UE_TX_test .dsn.

The basics for using the test bench are:

e Connect to an RF DUT that is suitable for this test bench.

e CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values are typically accepted; if not,
set values based on your requirements.

¢ Activate/deactivate measurement(s) based on your requirements.

¢ Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.

Test Bench Details

The following sections provide details for setting up a test bench, setting measurement parameters for more control of
the test bench, simulation measurement displays, and baseline performance.
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Open and use the template:

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_UE_TX_test, click OK; click left to place the template in
the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is suitable for this test bench.
For general information regarding using certain types of DUTs, see Appendix A, RF DUT Limitations.
2. Set the Required Parameters

) Note

Refer to 3GPPFDD_UE_TX for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the user as needed.

e Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data Flow simulation technology)
and the DUT (using Circuit Envelope simulation technology). Each technology requires its own simulation
time step with time-step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with this DUT. The CE_TimeStep
must be set to a value equal to or a submultiple of (less than) WTB_TimeStep; otherwise, simulation will
stop and an error message will be displayed.
The CE_TimeStep value is exported to the Choosing Analyses window in the Circuit Envelope Time Step
field when the user clicks OK in the Wireless Test Bench Setup window.
Note that WTB_TimeStep is not user-settable. Its value is derived from other test bench parameter values;
with default settings WTB_TimeStep=1/(3.84e6 x 8) sec. The value is displayed in the Data Display pages
as TimeStep.

WTB_TimeStep = 1/(ChipRate x SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during pulse forming.

e Set FSource, SourcePower, and FMeasurement.

° FSource defines the RF frequency for the signal input to the RF DUT. The FSource value is exported to
the Choosing Analyses window Fundamental Tones field when the user clicks OK in the Wireless Test
Bench Setup window.

° SourcePower defines the power level for FSource. SourcePower is defined as the average power during
the non-idle time of the signal.

° FMeasurement defines the RF frequency output from the DUT to be measured.

3. Activate/deactivate ( YES / NO ) test bench measurements (refer to 3GPPFDD UE TX). At least one
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measurement must be enabled.

4. More control of the test bench can be achieved by setting Basic Parameters, Signal Parameters, and parameters
for each activated measurement. For details refer to Parameter Settings.

5. The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench Block Diagram) uses FSource,
SourcePower ( Required Parameters ), MirrorSourceSpectrum ( Basic Parameters), Gainlmbalance,
PhaseImbalance, I OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).

The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource), with the specified source resistance
(SourceR) and with power (SourcePower) delivered into a matched load of resistance SourceR. The RF signal has
additive Gaussian noise power set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).

Note that the Meas_in point of the test bench provides a resistive load to the RF DUT set by the MeasR value
(50-ohm default) ( Basic Parameters ).

The Meas signal contains linear and nonlinear signal distortions and time delays associated with the RF DUT input
to output characteristics.

The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench Block Diagram) uses other
Signal Parameters.

6. More control of Circuit Envelope analysis can be achieved by setting Envelope controller parameters. These
settings include Enable Fast Cosim, which may speed the RF DUT simulation more than 10x. Setting these
simulation options is described in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.

7. To send the RF DUT output signal to an Agilent ESG RF signal generator, set parameters on the Signal to ESG
tab.

For details, refer to Signal to ESG Parameters.

8. To run a simulation, choose Simulation > Run in the Analog Design Environment main window.
For details, refer to R unning a Simulation in the Wireless Test Bench Simulation documentation.

9. Simulation results will appear in a Data Display window for each measurement. Simulation Measurement
Displays describes results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation documentation.

3GPPFDD_UE_TX

This section provides parameter information for Required Parameters, Basic Parameters, Signal Parameters, and
parameters for the various measurements.

3GFFFDD_UE_TH

Description 3GPP FDD UE Tx test

52


http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+UE+TX#3GPPFDDUETX-1231497
http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+UE+TX#3GPPFDDUETX-1279509
http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+UE+TX#3GPPFDDUETX-1279537
http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+UE+TX#3GPPFDDUETX-1279537

Library WTB

Class TSDF3GPPFDD_UE_TX
Derived From baseWTB_TX

Parameters

Name

Description

RequiredParameters

CE_TimeStep

WTB_TimeStep

FSource

SourcePower

FMeasurement

Circuit
envelope
simulation
time step

Set
CE_TimeStep
< =

Advanced Design System 2008

Default

1/3.84 MHz/8

1/3.84e6/SamplesPerChip.

SamplesPerChip

is in Signal
Parameters
tab.

Source carrier
frequency

Source power

Measurement
carrier
frequency

MeasurementInidAvailable

Measurements
Each
measurement
has
parameters on
its
tab/category
below.

RF_EnvelopeMea&unadrteeRE

envelope
measurement?
NO, YES

PowerMeasurem dftable power

measurement?
NO, YES

ACLR_Measuremé&mable ACLR

1950 MHz

dbmtow(-20.0)
1950 MHz

YES

NO

NO

Sym

sec

Hz

Hz
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Unit Type

real

real

real

real

enum

enum

enum

Range

(0, )

(0, )

[0, o)
(0, )
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measurement?
NO, YES

ACLR_ST_Measuemablie ACLR NO enum
switching
transients
measurement?
NO, YES

OccupiedBW_Medswrblment NO enum
occupied
bandwidth
measurement?
NO, YES

CDP_Measuremefhable code NO enum
domain power
measurement?
NO, YES

PCDE_Measuremé&ntble peak NO enum
code domain
error
measurement?
NO, YES

EVM_Measuremzhhable EVM NO enum
measurement?
NO, YES

BasicParameters

SourceR Source 50 Ohm Ohm real (0, o0)
resistance

SourceTemp Source -273.15 Celsius real [-273.15, o)
resistor
temperature

EnableSourceNcidmable source  NO enum
thermal noise?
NO, YES

MeasR Measurement = 50 Ohm Ohm real [10, 1.0e6]
resistance

MirrorSourceSpedditnor source NO enum
spectrum
about carrier?
NO, YES

MirrorMeasSpectmirror meas NO enum
spectrum
about carrier?
NO, YES
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MeasMirrorFreq

Mirror source
frequency for
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NO

spectrum/envelope

measurement?

NO, YES

Mirror meas
frequency for

NO

spectrum/envelope

measurement?

NO, YES

DUT_DelayBoundUT delay

TestBenchSeed

bound

Random
number
generator
seed

SignalParameters

GainImbalance

PhaseImbalance

I_OriginOffset

Q_OriginOffset

IQ_Rotation

SamplesPerChip

Gain
imbalance, Q
vs I

Phase
imbalance, Q
vs I

I origin offset
(percent)

Q origin offset
(percent)

IQ rotation

Samples per
chip

RRC_FilterLengthRRC filter

SpecVersion

SourceType

length (chips)

Secification
version:
Version
03_00,
Version
12_00,
Version 03_02

Source type:
UL_12_2,
UL_768

10.0 usec

1234567

0.0

0.0

0.0

0.0

16

Version 12_00

UL 12 _2

sec

dB

deg

deg
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enum

enum

real

int

real

real

real

real

real

int

int

enum

enum

(o,
(400.0/3840000)]

[0, o)

)

)

-00, 00)

[2, 32]

[2, 128]
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RF_EnvelopeMeasurementParameters

RF_EnvelopeDispRiyRagetope
measurement
display pages:
3GPPFDD_UE_TX_Envelope
Figures

RF_EnvelopeStarRF envelope 0.0
measurement
start

RF_EnvelopeStopRF envelope (2560/3.84)
measurement  usec
stop

RF_EnvelopeSlotRF envelope 1
measurement
slots

PowerMeasurementParameters

PowerDisplayPag@swer
measurement
display pages:
3GPPFDD_UE_TX_Power
Equations
3GPPFDD_UE_TX_Power
Table
3GPPFDD_UE_TX_Power
Figures

PowerStartSlot = Start slot 0

PowerSlotsMeasuséats 1
measured

ACLR_MeasurementParameters

ACLR_DisplayPag&ELR
measurement
display pages:
3GPPFDD_UE_TX_ACLR
Equations
3GPPFDD_UE_TX_ACLR
Table
3GPPFDD_UE_TX_ACLR
Figures

ACLR_Start Measurement 0.0

start
ACLR_Stop Measurement  (2560/3.84)
stop usec

sec

sec

sec

sec
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real

real

int

int

int

real

real

[0, o)

(0, )

[0, 100]

[0, o)
[0, )

[0, o)

(0, o)
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Measurement 0
slots

ACLR_SpecMeasRgs8Mfum 0

resolution
bandwidth

ACLR_SpecMeasWiitdtow type:  ACLR_none

ACLR_none,
ACLR_Hamming
0.54,
ACLR_Hanning
0.50,
ACLR_Gaussian
0.75,
ACLR_Kaiser
7.865,
ACLR_8510

6.0,
ACLR_Blackman,
ACLR_Blackman-Harris

ACLR_ST_MeasurementParameters

ACLR_ST_Display®algesST

ACLR_ST_Start

ACLR_ST_Stop

ACLR_ST_Slots

measurement

display pages:
3GPPFDD_UE_TX_ACLR_ST
Table
3GPPFDD_UE_TX_ACLR_ST
Equations

Measurement 0.0
start

Measurement @ (2560/3.84)
stop usec

Measurement 0
slots

OccupiedBW_MeasurementParameters

OBW_DisplayPag@scupied BW

OBW_ Start

measurement

display pages:
3GPPFDD_UE_TX_OBW
Equations
3GPPFDD_UE_TX_OBW
Table
3GPPFDD_UE_TX_OBW
Figures

Measurement 0.0
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Hz

sec

sec

sec

int

real

enum

real

real

int

real

[0, 100]

[0, o)

[0, o)

(0, )

[0, 100]

[0, o)
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start

Measurement @ (2560/3.84)
stop usec

Measurement 0
slots

OBW_SpecMeasRepBittrum 0

resolution
bandwidth

OBW_SpecMeasWitiddew type:  OBW_none

OBW_none,
OBW_Hamming
0.54,
OBW_Hanning
0.50,
OBW_Gaussian
0.75,
OBW_Kaiser
7.865,
OBW_8510

6.0,
OBW_Blackman,
OBW_Blackman-Harris

CDP_MeasurementParameters

CDP_DisplayPacesDP

CDP_StartSlot

measurement
display pages:

Start slot 0

PCDE_MeasurementParameters

PCDE_DisplayPed®sDE

measurement

display pages:
3GPPFDD_UE_TX_PCDE
Equations
3GPPFDD_UE_TX_PCDE
Table
3GPPFDD_UE_TX_PCDE
Figures

PCDE_StartSlot Start slot 0

EVM_MeasuremezntParameters

EVM_DisplayPages/M

measurement
display pages:
3GPPFDD_UE_TX_EVM
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sec

Hz

real

int

real

enum

int

int

(0, )

[0, 100]

[0, o)

[0, o)

[0, o)
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Equations
3GPPFDD_UE_TX_EVM
Table

Measurement | 0.0 sec real [0, )
start

EVM_SlotsMeasu&dts to 1 int [0, =)

measure

SignalToESG_Parameters

EnableESG

Enable signal NO enum
to ESG? NO,
YES

ESG_Instrument ESG [GPIB0::19::INSTR][localhost][4790] instrument

ESG_Start
ESG_Stop

ESG_Slots

ESG_Power

ESG_CIkRef

instrument
address

Signal start 0.0 sec real [0, o)

Signal stop (2560/3.84) sec real [(ESG_Start+60/3.84e6
usec (ESG_Start+32/3.84/S)

Slots to ESG 15 int [0, 1000]

ESG RF ouput  -20.0 real (-0, )
power (dBm)

Waveform Internal enum
clock

reference:

Internal,

External

ESG_ExtClkRefFrégternal clock = 10 MHz Hz real (0, )

ESG_IQFilter

reference freq

1Q filter: through enum
through,

filter_2100kHz,

filter_40MHz

ESG_SampleClkRaéguencer 30.72 MHz Hz real (0, o0)

ESG_Filename

sample clock
rate

ESG waveform @ 3GPPFDD_UL string
storage
filename

ESG_AutoScalingActivate auto YES enum

scaling? NO,
YES
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ESG_ArbOn Select YES enum
waveform and
turn ArbOn
after
download?
NO, YES

ESG_RFPowOn ' Turn RF ON YES enum
after
download?
NO, YES

ESG_EventMarkeEinmé marker | Eventl enum
type: Neither,
Eventl,
Event2, Both

ESG_MarkerLengB$%G marker 10 int [1, 60]
length

Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement timed
RF input from RF circuit

Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF ' timed
circuit

Parameter Settings

More control of the test bench can be achieved by setting parameters on the Basic Parameters, Signal Parameters,
and measurements categories for the activated measurements. Parameters for each category are described in the
following sections.

 Note

For required parameter information, see Set the Required Parameters.

Basic Parameters
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1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise density in the RF output signal
to (k(SourceTemp+273.15)) Watts/Hz, where k is Boltzmann's constant.

3. EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it to -273.150C (0 Kelvin).
When set to YES, the noise density due to SourceTemp is enabled.

4. MeasR defines the load resistance for the RF DUT output Meas signal into the test bench. This resistance loads
the RF DUT output; it is also the reference resistance for Meas signal power measurements.

5. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the generated RF signal before it is sent
to the RF DUT. Depending on the configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set this parameter to YES.

6. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in RF signal input to the test
bench (and output from the RF DUT). Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and measurement of the RF DUT
output signal requires that its RF envelope is not mirrored compared to the signal generated by the signal source
(before any mirroring is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for measurements on the
Meas_in signal in TX test benches (EVM, Constellation, CDP, PCDE) and results in measurement on a signal with
no spectrum mirroring.

7. TestBenchSeed is an integer used to seed the random number generator used with the test bench. This value is
used by all test bench random number generators, except those RF DUT components that use their own specific
seed parameter. TestBenchSeed initializes the random number generation. The same seed value produces the
same random results, thereby giving you predictable simulation results. To generate repeatable random output
from simulation to simulation, use any positive seed value. If you want the output to be truly random, enter the
seed value of 0.

8. RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal for RF envelope, ppectrum,
ACLR, and occupied bandwidth measurements. RF_MirrorFreq is typically set by the user to NO when
MirrorSourceSpectrum = NO; RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum =
YES. Both settings result in viewing the RF_out signal with no spectrum mirroring. Other settings by the user
result in RF_out signal for RF_Envelope and Spectrum measurements with spectrum mirroring.

9. MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF signal for the RF envelope,
spectrum, ACLR, and occupied bandwidth measurements.

MeasMirrorFreq is typically set to NO by the user when the combination of the MirrorSourceSpectrum value and
any signal mirroring in the users RF DUT results in no spectrum mirroring in the Meas_in signal. MeasMirrorFreq
is typically set to YES by the user when the combination of the MirrorSourceSpectrum and RF DUT results in
spectrum mirroring in the Meas_in signal.

Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements with spectrum mirroring.
The MirrorMeasSpectrum parameter setting has no impact on the setting or use of the MeasMirrorFreq
parameter.

10. DUT_DelayBound is used to transfer the DUT delay for measurement synchronization. For measurements of
RF_out before the DUT, RF delay bound is calculated by adding the delays caused by RRC filters in modulation
and measurements. For measurements of the RF DUT output (Meas_in), the Meas delay bound is calculated by
adding the DUT_DelayBound to the RF delay bound.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are used to add certain
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impairments to the ideal output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance applied. The RF is given by:

Veplt) = ALV;H'CD”LQ tl—ngI‘tIDlﬂl\ﬂ t+ FSEDJ ]

where A is a scaling factor that depends on the SourcePower and SourceR parameters specified by the user, VI (
t ) is the in-phase RF envelope, V Q ( t ) is the quadrature phase RF envelope, g is the gain imbalance

Gainlmbalance

g = 10 30

and, ® (in degrees) is the phase imbalance.

Next, the signal V RF ( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and Q_OriginOffset are then
applied to the rotated signal. Note that the amounts specified are percentages with respect to the output rms
voltage. The output rms voltage is given by sqrt(2 x SourceR x SourcePower).

2. SamplesPerChip is used to set the number of samples in a chip. The default value is set to 8 to display settings
according to the 3GPP standard. It can be set to a larger value for a simulation frequency bandwidth wider than
8 x 3.84 MHz. It can be set to a smaller value for faster simulation times; however, this will result in lower signal
fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger than the signal bandwidth by a factor of 8
(e.g., simulation RF bandwidth = 8 x 3.84 MHz).

3. RRC_FilterLength is used to set root raised-cosine filter length in chips. The default value is set to 16 to transmit
a 3GPP FDD uplink signal in time and frequency domains based on the 3GPP standard [4]. It can be set to a
smaller value for faster simulation times; however, this will result in lower signal fidelity. Better Adjacent
Channel Leakage Ratio (ACLR) can be obtained using a longer filter length. Increasing RRC_FilterLength to 24 or
32 should result in a better ACLR. This may also correlate better to ACLR measurements when using instruments
from Agilent Technologies.

4. SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12 or 2002-03.

5. SourceType is used to specify the type of baseband signal. Reference measurement channels 12.2 and 768 kbps
as defined in [4] and [5] are available. Basic parameters of these channels are listed in the following tables.

Uplink 12.2 kbps Reference Measurement Channel, Physical Parameters

Parameter Unit Level
Information bit rate kbps 12.2
DPDCH kbps 60
DPCCH kbps 15
DPCCH Slot Format 0
DPCCH/DPDCH power ratio dB -5.46
TFCI On
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Repetition % 23

Uplink 12.2 kbps Reference Measurement Channel, Transport Channel Parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 244 100
Transport Block Set Size 244 100
Transmission Time Interval 20 ms 40 ms
Type of Error Protection Convolution Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12

Uplink 768 kbps Reference Measurement Channel, Physical Parameters

Parameter Unit Level
Information bit rate kbps 2*384
DPDCH1 kbps 960
DPDCH?2 kbps 960
DPCCH kbps 15
DPCCH Slot Format 0
DPCCH/DPDCH power ratio dB -11.48
TFCI On
Puncturing % 18

Uplink 768 kbps Reference Measurement Channel, Transport Channel Parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 3840 100
Transport Block Set Size 7680 100
Transmission Time Interval 10 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
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Rate Matching attribute 256 256

Size of CRC 16 12

RF Envelope Parameters

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply spectrum mirroring to the
measured RF_out signal, set RF_MirrorFreq = YES. To apply spectrum mirroring to the measured Meas_in signal, set
MeasMirrorFreq = YES.

1. RF_EnvelopeDisplayPages provides Data Display page information for this measurement. It cannot be changed
by the user.

2. RF_EnvelopeStart sets the start time for collecting input data.

RF_EnvelopeStop sets the stop time for collecting input data when RF_EnvelopeSlots = 0.

4. RF_EnvelopeSlots (when > 0) sets the number of slots over which data will be collected.

w

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and RF_EnvelopeSlots, the stop time may be
adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:
Start = TimeStep * (int(RF_EnvelopeStart/TimeStep) + 0.5)
Stop = TimeStep * (int(RF_EnvelopeStop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step intervals.

RF_EnvelopeSlots Resultant Stop Time
0 Stop

>0 Start + RF_EnvelopeSlots x SlotTime

For the RF envelope of Meas_in to contain at least one complete slot, the Stop value should be set to a minimum of
SlotTime + (RF DUT time delay).

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

Power Measurement Parameters
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PowerDisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

PowerStartSlot sets the number of slots which should be ignored.

PowerSlotsMeasured sets the number of slots over which data will be collected.

The measurement start time is PowerStartSlot x SlotTime. The measurement stop time is
(PowerStartSlot+PowerSlotsMeasured) x SlotTime. SlotTime is defined in Test Bench Variables for Data Displays.

ACLR Measurement Parameters

The ACLR measurement is implemented by the spectrum measurement, which measures the RF signal spectrum in
different frequency offsets. The ACLR can be calculated by analyzing the spectrum measurement in the data display

file.

In the following, TimeStep denotes the simulation time step, and FMeasurement denotes the measured RF signal

cha

1

N

ou kW

racterization frequency.

. The measurement outputs the complex amplitude voltage values at the frequencies of the spectral tones. It does

not output power at frequencies of the spectral tones. However, one can calculate and display the power
spectrum as well as the magnitude and phase spectrum by using the dBm, mag, and phase functions of the data
display window.

Note that the dBm function assumes a 50-ohm reference resistance; if a different measurement was used in the
test bench, its value can be specified as a second argument to the dBm function, for example, dBm(SpecMeas,
Meas_RefR) where SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the resistive
load used.

By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz to FMeasurement +
1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the default spectrum extends to negative frequencies.
The spectral content at these negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed on the positive frequency
axis as would happen in an RF spectrum analyzer measurement instrument. This process may introduce an error
in the displayed frequency for the mirrored tones. The absolute error introduced is less than (spectrum frequency
step) / 2 (see the following table for the definition of spectrum frequency step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z transform. The algorithm can use
multiple slots and average the results to achieve video averaging (see note 6).

ACLR_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

ACLR_Start sets the start time for collecting input data.

ACLR_Stop sets the stop time for collecting input data when ACLR_Slots = 0 and ACLR_SpecMeasResBW = 0.
ACLR_Slots (when > 0) sets the number of slots over which data will be collected.

ACLR_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum measurement.

Depending on the values of ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW, the stop time may be adjusted
and/or spectrum video averaging may occur. The different cases are explained in the following table.

Referring to the following table let:

Start = TimeStep x int((ACLR_Start/TimeStep) + 0.5)
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Stop = TimeStep x int((ACLR_Stop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular filter. It is the equivalent
width of a rectangular filter that passes the same amount of white noise as the window. The normalized ENBW is
the ENBW multiplied by the time duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window options available.

The Start and Stop times are used for both the RF_out and Meas_in signal spectrum analyses. The Meas_in
signal is delayed in time from the RF_out signal by the value of the RF DUT time delay. Thus for RF DUT time
delay > 0, the RF_out and Meas_.in signal are inherently different and some spectrum display difference in the
two is expected.

TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

Effect of Different Values for ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW

Case 1 ACLR_Slots = 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case 2 ACLR_Slots > 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Start + ACLR_Slots x SlotTime

Notes: For ACLR_Slots > 0 and
ACLR_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals

Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when ACLR_Slots > 1

Case 3 ACLR_Slots = 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimelnterval
where
N = int((Stop -Start)/SlotTimelnterval) + 1

For ACLR_Slots = 0 and ACLR_SpecMeasResBW >
0

Define SlotTimelnterval = TimeStep *
int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)
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This means SlotTimelnterval is forced to a value
that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number
(N) of SlotTimelnterval

N has a minimum value of 1

Video averaging occurs over all SlotTimelnterval
The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
ACLR_SpecMeasResBW but may not be exactly the
same if X/(ACLR_SpecMeasResBW*TimeStep) is
not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case 4 ACLR_Slots > 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimelnterval
where
M = int((ACLR_Slots x SlotTime)/SlotTimelnterval) + 1

For ACLR_Slots > 0 and ACLR_SpecMeasResBW >
0

Define SlotTimelnterval = TimeStep *
int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimelnterval is forced to a value
that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number
(M) of the SlotTimelnterval

M has a minimum value of 1

Video averaging occurs over all SlotTimelntervals
The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
ACLR_SpecMeasResBW but may not be exactly the
same if X/(ACLR_SpecMeasResBW*TimeStep) is
not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

7. ACLR_SpecMeasWindow specifies the window that will be applied to each slot before its spectrum is calculated.

Different windows have different properties, affect the resolution bandwidth achieved, and affect spectral shape.
Windowing is often necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral
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distortion due to discontinuous or non-harmonic signal over the measurement time interval. Without windowing,
the estimated spectrum may suffer from spectral leakage that can cause misleading measurements or masking
of weak signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum measurement compensates
for this and the spectrum is normalized so that the power contained in it is the same as the power of the input
signal.
Window Type Definitions:

e none

wkT) = | 1.0 0<k=N
) 0.0  otherwise

where N is the window size
e Hamming 0.54

Ik’

wkT,) = ‘ 0.54 — D%m[ ) 0<k<N
0.0 otherwise
where N is the window size
e Hanning 0.50
w(AT.) = o5 05cos(ZEk)  0<keN
0.0 otherwise

where N is the window size
° Gaussian 0.75

(1 (2 k—ﬁl‘- = Nl N
wik Ts 1= CAPL LD i N /'l 0=k~ ?v‘ = ?
0.0 otherwise
where N is the window size
° Kaiser 7.865
- 172
‘ IDL?.SISS[l - Lk a)” ] )
[ A A
wkT ) = : 0<k<N
0.0 otherwise

where N is the window size, a =N/ 2, and I 0 (.) is the Oth order modified Bessel function of the first
kind
°© 8510 6.0 (Kaiser 6.0)
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‘ Ig[a_o[l_[t“/‘f] )
Igl;lffl.[]]

0.0 otherw ise

0<k=N

w(kT ) =

where N is the window size, a = N/ 2, and I 0 (.) is the Oth order modified Bessel function of the first

kind
° Blackman
wkT ) = ‘ 0420, SmQL hk 4+ 0. nsmuf:ff | 0<k<N
0.0 otherwise
where N is the window size
° Blackman-Harris
wkT,) = ‘ 035875 - 0.48829 coﬂthk | +0.14128 couL_mk | —0.01168 couLﬁ:ﬁ | 0<k<N
0.0 otherwise
where N is the window size.
Window Options and Normalized Equivalent Noise Bandwidth
Window and Default Constant NENBW
none 1
Hamming 0.54 1.363
Hanning 0.50 1.5
Gaussian 0.75 1.883
Kaiser 7.865 1.653
8510 6.0 1.467
Blackman 1.727
Blackman-Harris 2.021

ACLR due to Switching Transient Measurement Parameters

1. ACLR_ST_DisplayPages provides Data Display page information for this measurement. It cannot be changed by

the user.
2. ACLR_ST_Start sets the start time for collecting input data.

3. ACLR_ST_Stop sets the stop time for collecting input data when ACLR_ST_Slots = 0.
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4. ACLR_ST_Slots (when > 0) sets the number of slots over which data will be collected.

Depending on the values of ACLR_ST_Start, ACLR_ST_Stop, and ACLR_ST_Slots, the stop time may be adjusted.

For ACLR ST measurement for both the RF_out and Meas_in signals:

Let:
Start = TimeStep x (int(ACLR_ST_Start/TimeStep) + 0.5)
Stop = TimeStep x (int(ACLR_ST_Stop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step intervals.

0

>0

ACLR_ST_ Slots Resultant stop time
Stop

Start + ACLR_ST_Slots x SlotTime

For the ACLR ST of Meas_in to contain at least one complete slot, the Stop value should be set to a minimum of
SlotTime + (RF DUT time delay).

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

OBW Measurement Parameters

The occupied bandwidth measurement is implemented by the spectrum measurement which measures the spectrum
of the input signal. The occupied bandwidth is calculated by analyzing the spectrum measured in data display files.

In the following notes, TimeStep denotes the simulation time step, and FMeasurement denotes the measured RF
signal characterization frequency.

1.

2.

OBW_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

The measurement outputs the complex amplitude voltage values at spectral tone frequencies.

Spectral tone frequency power is not output; however, power, magnitude, and phase spectrums can be
calculated and displayed by using the dBm, mag, and phase functions of the data display window. Note that the
dBm function assumes a 50-ohm measurement reference resistance; if a different reference resistance
measurement is used in the test bench, its value can be specified as a second argument to the dBm function; for
example, dBm(SpecMeas, Meas_RefR) where SpecMeas is the instance name of the spectrum measurement and
Meas_RefR is the resistive load used.

By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz to FMeasurement +
1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the default spectrum extends to negative frequencies.
The spectral content at these negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed on the positive frequency
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axis as would happen in an RF spectrum analyzer measurement instrument. This process may introduce an error
in the displayed frequency for the mirrored tones. The absolute error introduced is less than (spectrum frequency
step) / 2 (see the following table for the definition of spectrum frequency step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z transform. The algorithm can use
multiple slots and average the results to achieve video averaging (see note 8).

OBW_Start sets the start time for collecting input data.

OBW_Stop sets the stop time for collecting input data when OBW_Slots = 0 and OBW_SpecMeasResBW = 0.
OBW_Slots (when > 0) sets the number of slots over which data will be collected.

OBW_SpecMeasResBW (when > 0)sets the resolution bandwidth of the spectrum measurement.

Depending on the values of OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW, the stop time may be adjusted
and/or spectrum video averaging may occur. The different cases are explained in the following table.

Let:

Start = TimeStep x int((OBW_Start/TimeStep) + 0.5)

Stop = TimeStep x int((OBW_Stop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer humber of time step intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular filter. It is the equivalent
width of a rectangular filter that passes the same amount of white noise as the window. The normalized ENBW is
the ENBW multiplied by the time duration of the signal being windowed. See Window Options and NENBW for the
normalized ENBW for the different window options available.

Effect of Different Values for OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW

Case 1 OBW _Slots = 0

OBW_SpecMeasResBW = 0

Resultant stop time = Stop

Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case 2 OBW_Slots > 0

OBW_SpecMeasResBW = 0
Resultant stop time = Start + OBW_Slots x SlotTime

For OBW_Slots > 0 and OBW_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals

Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when OBW_Slots > 1

Case 3 OBW_Slots = 0

OBW_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimelnterval
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where
N = int((Stop -Start)/SlotTimelnterval) + 1

For OBW_Slots = 0 and OBW_SpecMeasResBW > 0
Define SlotTimelnterval = TimeStep *
int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimelnterval is forced to a value
that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number
(N) of SlotTimelInterval

N has a minimum value of 1

Video averaging occurs over all SlotTimelnterval
The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the
same if X/(OBW_SpecMeasResBW*TimeStep) is not
an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

OBW _Silots > 0

OBW_SpecMeasResBW > 0

Resultant stop time = Start + M*SlotTimelnterval
where

M = int((OBW_Slots x SlotTime)/SlotTimelnterval) + 1

For OBW_Slots > 0 and OBW_SpecMeasResBW > 0
Define SlotTimelnterval = TimeStep *
int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimelnterval is forced to a value
that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number
(M) of the SlotTimelnterval

M has a minimum value of 1

Video averaging occurs over all SlotTimelnterval
The resolution bandwidth achieved is ResBW = X /
SlotTimelnterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the
same if X/(OBW_SpecMeasResBW*TimeStep) is not
an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1
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The Start and Stop times are used for both the RF_out and Meas_in signal spectrum analyses. The Meas_in
signal is delayed in time from the RF_out signal by the value of the RF DUT time delay. Thus for RF DUT time
delay greater than zero, the RF_out and Meas_in signal are inherently different and some spectrum display
difference in the two is expected.

TimeStep and Slot_Time are defined in Test Bench Variables for Data Displays

. OBW_SpecMeasWindow specifies the type of window. Different windows have different properties, affect the
resolution bandwidth achieved, and affect spectral shape. The OBW_SpecMeasWindow is used to define the
window that will be applied to each slot before its spectrum is calculated. Windowing is often necessary in
transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral distortion due to discontinuous or
non-harmonic signal over the measurement time interval. Without windowing, the estimated spectrum may
suffer from spectral leakage that can cause misleading measurements or masking of weak signal spectral detail
by spurious artifacts.

Window Type Definitions:

¢ Hanning
r 2nk .
‘ W-(l-W)cos| ————| 0<k<NPoints
w(kT) = ' Lf"n.'Pomtse*' oL
1 0.0 otherwise
where W = WindowConstant
e Hamming
C 2mk 0 .
‘ W-(1-W)cos| ————| 0<k<NPoints
w(kT) = I‘ L;"‘»‘Pomts«f oLr
1 0.0 otherwise
where W = WindowConstant
e Blackman
F 2wk o O o4nk .
042 - 05cos| —— |+ 0.08co8) —"r——| D<k <NPoints
w(kT) = - LE"»'POLR#S«" Lﬁ'Po.&na‘Sf'
0.0 otherwise
e Kaiser (Kaiser-Bessel)
[ T ey 29102
1( B[ (= 1)
o E - .
wkT) = - — 0<k <NPoirts
= I':II'-BI
0.0 otherwise

Here a = NPoints / 2, B is the shape parameter (set by WindowConstant ), and I 0 (.) is the 0 th order
modified Bessel function of the first kind.
e Gaussian (Weierstrass)
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o ‘ EXP[_Fl_j[allfkh};urgoiizts]‘:lz‘:l o<z _E-.T.Pclints Eﬁrpiints
wikl ) = 2 NFolrts /¢ 2 2
1 0.0 otherwise
where a = WindowConstant.
Window Options and NENBW
Window and Default Constant Normalized Equivalent Noise BW (X)
None 1
Hamming 0.54 Not defined (1 is used)
Hanning 0.50 1.5
Gaussian 0.75 2.215
Kaiser 7.865 Not defined (1 is used)
8510 6.0 Not defined (1 is used)
Blackman Not defined (1 is used)
Blackman-Harris Not defined (1 is used)

The windowing of a signal in time has the effect of changing its power. The spectrum measurement
compensates for this and the spectrum is normalized so that the power contained in it is the same as the
power of the input signal.

CDP Measurement Parameters

1. CDP_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

2. CDP_StartSlot sets the starting slot from which slot data will be collected. The CDP_StartSlot is used for both the
RF_out and Meas_in CDP analyses.

The measurement interval is one timeslot. The length of time that data will be collected is SlotTime. See Test Bench
Equations Derived from Test Bench Parameters and Exported to the Data Display.

PCDE Measurement Parameters

1. PCDE_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.
2. PCDE_StartSlot sets the starting slot from which slot data will be collected. PCDE_StartSlot is used for both
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RF_out and Meas_in PCDE analyses.

The measurement interval is one timeslot. The length of time that data will be collected is SlotTime. See Test Bench

Equations Derived from Test Bench Parameters and Exported to the Data Display.

EVM Parameters

1.

2.

EVM_DisplayPages provides Data Display page information for this measurement. It cannot be changed by the
user.

EVM_Start specifies starting time instant for the measurement. EVM_Start time is used for RF_out and Meas_in
EVM analyses. The Meas_.in signal is delayed in time from the RF_out signal by the RF DUT time delay value.
Thus for RF DUT time delay >0, RF_out and Meas_in signals are inherently different and some EVM difference in
the two is expected even if the RF DUT does not introduce any distortion other than time delay.
EVM_SlotsMeasured specifies the measurement interval. The time length of data to be collected is
EVM_SlotMeasuredx SlotTime. See Test Bench Equations Derived from Test Bench Parameters and Exported to

the Data Display.

Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an Agilent E4438C Vector Signal
Generator. This measurement uses Connection Manager architecture to communicate with the instrument; parameters
specify how data is interpreted.

Prerequisites for using the Signal to ESG option are:

e ESG Vector Signal Generator E4438C; for information, visit the web site http://www.agilent.com/find/esg.
e PC workstation running an instance of the connection manager server.
e Supported method of connecting the instrument to your computer through the Connection Manager architecture;

for information, see Connection Manager.

Parameter Information

1.

2.

EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO, no attempt will be made to
communicate with the instrument.

ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument to be used in the
simulation, the connection manager server hostname (defaults to localhost ), and the port at which the
connection manager server listens for incoming requests (defaults to 4790). To ensure that this field is populated
correctly, click Select Instrument, enter the server hostname and port, click OK to see the Remote Instrument
Explorer dialog, select a VSA resource identifier, and click OK. For details about selecting instruments, see
Instrument Discovery in the Wireless Test Bench Simulation documentation.
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ESG_Start and ESG_Stop (when ESG_Slots=0) specify when to start and stop data collection. The number of
samples collected, ESG_Stop - ESG_Start + 1, must be in the range 60 samples to 64 Msamples, where 1
Msample = 1,048,576 samples. The ESG requires an even number of samples; the last sample will be discarded
if ESG_Stop - ESG_Start + 1 is odd.

ESG_Slots sets the number of slots over which data will be collected. When ESG_Slots > 0, ESG_Stop is forced
to ESG_Start + ESG_Slots x SlotTime (where SlotTime is 5 msec).

ESG_ClkRef specifies an internal or external reference for the ESG clock generator. If set to External, the
ESG_ExtClkRefFreq parameter sets the frequency of this clock.

ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies between the DAC output and the
Dual Arbitrary Waveform Generator output inside the ESG.

ESG_SampleClkRate sets the sample clock rate for the DAC output.

ESG_FileName sets the name of the waveform inside the ESG that will hold the downloaded data.

The ESG driver expects data in the range {-1, 1}. ESG_AutoScaling specifies whether to scale inputs to fit this
range. If set to YES, inputs are scaled to the range {-1, 1}; if set to NO, raw simulation data is downloaded to
the ESG without any scaling, but data outside the range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also
applied to data written to the local file (ESG_FileName setting).

If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after simulation data is
downloaded; if set to NO, waveform generation must be turned on at the ESG front panel.

If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after simulation data is downloaded.
If ESG_RFPowOn is set to NO (default), RF power must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Eventl, Event2, Both, or Neither. Event
markers are used for synchronizing other instruments to the ESG. When one or both EventMarkers are enabled,
Eventl and/or Event2 is set beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting the corresponding event from
the front panel of the ESG.

ESG_MarkerLength specifies the range of points over which the markers must be set starting from the first point
of the waveform. Depending on the setting of ESG_EventMarkerType, the length of trigger Eventl or Event2 (or
both) is set to a multiple of the pulsewidth that, in turn, is determined by the sample clock rate of the DAC
output.

Simulation Measurement Displays

After running the simulation, results are displayed in the Data Display pages for each measurement activated.

Li]

Note

Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless Test
Benches.

RF Envelope Measurement

The RF Envelope measurement (not defined in 3GPP specifications) shows the time envelope of the 3GPP FDD RF
signal. Two kinds of signals are tested: the RF signal which does not go through the DUT, and the Meas signal which
does go through the DUT and may contain a few microseconds of delay, some noise, and nonlinearity.
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Measurement results are shown in the following figure. Tables at the top of the data display page show some basic
measurement parameters. The waveforms show the envelopes of the RF and Meas signals. Two markers identify the
start points of the stable signals. An equation for Delay is defined to calculate the difference in time domain between
the two markers. The value of Delay is displayed in a table to indicate the delay caused by the DUT.

real{RF_FSourcedil MHZ) real{(RF_Power_dBm) realiRF_F)
TH50.000 24000 a0.000
realiMeas_FMeasurementii1 MHZ) realiMeas_RefR)
TU50 000 a0.000
real{ChipRateli1 MHzZ) real{ChipsPerSlof) realiSlotTimel(l usec) real(FrameTime){ 1msec)
3840 2560000 BEE.BERT 10,000
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RF Envelope Measurement Results

Power Measurement

The power measurement measures the CCDF (complementary cumulative distribution function) curves of the

transmitter (CCDF is not defined in 3GPP specifications). The CCDF and the peak-to-average ratio is calculated for the
3GPP FDD RF signal.

Two kinds of signals are tested: the RF signal which does not go through the DUT; and, the Meas signal which does go
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through the DUT and may contain a few microseconds of delay, some noise, and nonlinearity.

The data display contains three pages. The following figure shows peak power, mean power and peak-to-mean ratio of
RF and Meas signals.

reallRF_FSourcelf1 MHzZ) realfRF_Power _dBm) reallRF_R)
1350000 24 00 50,000
real(Meas_FMeasurement (1 bHZ) realMeaz_Reth)
0,000 =00

RF Power Measurement

RF_Peak_to_Mean_db RF_Power CCDF MeanPower_dBm RF_Power CCOF PeakPower_dBm
- B F153 B e T NN I FrEEY

Meas Power Measurement

Feak_to_hMean_dB Meas _Power CCDF MeanPower _dBm | Meas_Power CCDF PeakPovwer _dBm
375 25003 2T

RF and Meas Signal Power Ratios

The following figure shows two CCDF curves of RF and Meas signals. The 3GPPFDD_UE_TX_Power Equations page
includes two equations that are defined to calculate peak-to-mean ratio of the RF and Meas signals.
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CCDF Curves

ACLR Measurement

Signal Pawer-hean Power (dB)

This measurement is used to test adjacent channel leakage power ratio (ACLR) defined in 3GPP TS 25.101, section

6.6.2.2.

ACLR is the ratio of the RRC filtered mean power centered on the assigned channel frequency to the RRC filtered mean

power centered on an adjacent channel frequency. Two kinds of signals are tested: the RF signal which does not go
through the DUT; and, the Meas signal which does go through DUT and may contain a few of microseconds of delay,

some noise and nonlinearity.

In the data display, measurement results are automatically compared with pass/fail criteria defined in 3GPP TS
25.101, table 6.11. The comparison results are displayed on the 3GPPFDD_UE_TX_ACLR Table page (the following

figure).

The data display contains three pages. The 3GPPFDD_UE_TX_ACLR Table page (the following figure) shows adjacent
channel power and adjacent power ratio of the RF and Meas signals.

79



Advanced Design System 2008
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ACLR Measurement Results

The 3GPPFDD_UE_TX_ACLR Figures page (the following figure) shows the spectrum of the main channel and adjacent
channels of the RF and Meas signals. The 3GPPFDD_UE_TX_ACLR Equations page includes several equations that are
defined to calculate adjacent channel power and adjacent channel power ratio of the RF and Meas signals.
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ACLR Spectrums

ACLR Due to Switching Transient Measurement

This ACLR_ST measurement is used to test adjacent channel leakage power ratio (ACLR) in the presence of switching
transients, defined in 3GPP TS 25.101, section 6.6.2.2, Note 1.

ACLR is the ratio of the RRC filtered mean power centered on the assigned channel frequency to the RRC filtered mean
power centered on an adjacent channel frequency. Two kinds of signal are tested: the RF signal which does not go

through the DUT; and, the Meas signal which does go through the DUT and may contain a few microseconds of delay,
some noise, and nonlinearity.
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In the data display, the measurement results are automatically compared with pass/fail criteria defined in 3GPP TS
25.101, table 6.11, and the comparison results are displayed on the 3GPPFDD_UE_TX_ACLR_ST Table page (the
following figure).

The data display contains two pages. The 3GPPFDD_UE_TX_ACLR_ST Table page (the following figure) shows adjacent
channel power and adjacent power ratio of the RF and Meas signals. The 3GPPFDD_UE_TX_ACLR_ST Equations page
includes several equations that are defined to calculate adjacent channel power and adjacent channel power ratio of
the RF and Meas signals.
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AGPP Specification TS 25101 (2000-12) section 6.6 2 .2
Specification Requirements Test Result

#5 MHz or .5 MHz 33 4B 0

Passed Cantion, ACP greater than -50dBim

#10 MH= or - 10 MHz 43 4B

ACLR_ST Measurement Results

Occupied Bandwidth Measurement

The occupied bandwidth (OBW) measurement is defined in 3GPP TS 25.104, section 6.6.1. OBW is a measure of the
bandwidth containing 99% of the total integrated power for transmitted spectrum and is centered on the assigned
channel frequency. The occupied channel bandwidth must be less than 5 MHz based on a chip rate of 3.84 Mcps.

Two kinds of signals are tested: the RF signal which does not go through the DUT; and, the Meas signal which does go
through the DUT and may contain a few microseconds of delay, some noise, and nonlinearity.
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In the data display, measurement results are automatically compared with pass/fail criteria defined in 3GPP TS
25.101, section 6.6.1, and the comparison results are displayed on 3GPPFDD_UE_TX_OBW Table page (the following

figure).

At the top of each page, an identical table contains basic measurement parameters. The 3GPPFDD_UE_TX_OBW Table
page (the following figure) shows the resolution bandwidth and the occupied bandwidth of the RF and Meas signals.
Adjust the markers using the keyboard arrow keys until the Lower Side and the Higher Side power ratio equals 0.5%.
The 3GPPFDD_UE_TX_OBW Table page (the following figure) shows the equations used to calculate the occupied
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bandwidth, and the criteria used to determine if the results pass or not.

real{lRF_FSourced(T MHz) real(RF_Fower_dBrm) real(RF_F)
TOE0 o0 24000 50,000
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Tos0 000 s0.00

RF Occupied Bandwidth

RF_Cccupied_BWW_MHz

RF_Resolution_BandWidth_kHz

47155 150
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0495 0457 0257
Meas Occupied Bandwidth
Meas_Occupied BW_MHz Meas_Resolulion_BandWidth_kHz
£155 1.50
Meas_Lower_Side_percentage Meas_Higher_Side_percentage Meas_Total_Power W
.44h .45 0257
AGPP Specification TS 25 10%200012)  section 6.6.1
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Occupied Bandwidth Measurement Results
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The 3GPPFDD_UE_TX_OBW Figures page (the following figure) shows the spectrum of the RF and Meas signals with
two markers placed on each spectrum.
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The Occupied  BW wall then di splay the resulting bandwidth containing 39% of the transmitted power.

Occupied Bandwidth Signal Spectrums

CDP Measurement

Code domain power (CDP) is a measure of power distribution on code domain (not defined in the 3GPP specifications).

The CDP is calculated by projecting the power onto the code domain at a specified spread factor (256). The CDP for
every code in the domain is defined as the ratio of the mean power of the projection onto that code, to the mean
power of the composite reference waveform. The measurement interval is one timeslot. Two kinds of signals are
tested: the RF signal which does not go through the DUT, and the Meas signal which does go through the DUT and
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may contain a few microseconds of delay, some noise, and nonlinearity.

Results are shown in the following figure.
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CDP Measurement Results

PCDE Measurement

This measurement is used to test peak code domain error (PCDE) defined in 3GPP TS 25.101, section 6.8.3.

PCDE is calculated by projecting the power of the error vector onto the code domain at a specified spread factor. The
code domain error for every code in the domain is defined as the ratio of the mean power of the projection onto that
code, to the mean power of the composite reference waveform. This ratio is expressed in dB. The PCDE is defined as
the maximum value for the code domain error for all codes. The measurement interval is one timeslot. Two kinds of

Code Index of Laver §
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signals are tested: the RF signal which does not go through the DUT, and the Meas sighal which does go through the
DUT and may contain a few microseconds of delay, some noise and nonlinearity.

In the data display, the measurement results are compared automatically with pass/fail criteria defined in 3GPP TS
25.101, section 6.8.3.1. Comparison results are displayed on the 3GPPFDD_UE_TX_PCDE Table page (the following
figure).

The data display contains three pages. The 3GPPFDD_UE_TX_PCDE Table page (the following figure) shows the peak
code domain error of the RF and Meas signals.

real(RF_FSource)(l MHzZ) real{RF_Power_dBm) real(RF_R)
TOE0000 78000 RO.00
real{Maas_FMeasurementi/(1 MHZ) realiMeas_RelR)
TEs0. 000 50,000
RF Peak Code Domain Error  Meas Peak Code Domain Error
RF_Q_Ch_Peak_Coade_Damain_Errar_dg Q_Ch_Peak_Code_Domain_Eor_dB
—IBE.SE BEITE
RF_I_Ch_Peak_Code_Domain_Ernor_dB |_Ch_Peak_Code_Domain_Error_dB
- 26539 57131

3GPP Specification TS 25.101(2000-12) section 6.8.3

Specification Requirements Test results

The Peak Code Domain Error shall not exceed -15 dB Passed

PCDE Measurement Results

The 3GPPFDD_UE_TX_PCDE Figures page (the following figure) shows the code domain error of the RF and Meas
signals; markers indicate the peak values. The 3GPPFDD_UE_TX_PCDE Equations page shows the equations used to
calculate peak code domain error, and the criteria used to determine if the results pass or not.
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PCDE Waveforms

EVM Measurement

This measurement is used to test error vector magnitude (EVM) defined in 3GPP TS 25.101, section 6.8.2.

EVM is a measure of the difference between the theoretical waveform and a modified version of the measured
waveform. This difference is called the error vector. The measured waveform is modified by first passing it through a
matched Root Raised Cosine filter with a bandwidth of 3.84MHz and 0.22 roll-off. The waveform is then further
modified by selecting the frequency, absolute phase, absolute amplitude, and chip clock timing so as to minimize the
error vector. The EVM result is defined as the root of the mean error vector power though the mean reference signal
power expressed as a percent. The EVM cannot exceed 17.5%.

The data display contains two pages. At the top of each page, an identical table contains some basic measurement
parameters. The 3GPPFDD_UE_TX_EVM Table page (the following figure) shows the EVM of the RF and Meas signals.
The 3GPPFDD_UE_TX_EVM Equations page shows the criteria used to determine if the results pass or not.
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real(RF_FSource)l/i1 MHz) real(RF_Power_dBrm) real(RF_R)
1250000 24000 50,000
real(Meas_FMeasurement)fi1 Hz) realifeas_RefH]
1550 000 S0 000
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AGPP Specification TS 25 101 (2000-12) section 682
Specification requirements Test results

The madulation accuracy EVM shall not exceed Passed
17.5% for the parameters specified in Table 615
of TS 25101 section 6.8.2

EVM Measurement Results

Test Bench Variables for Data Displays

The following tables identify the reference variables used to set up this test bench:

Test Bench Constants Used to Set up 3GPP FDD User Equipment Signal

Constant Value

SamplesPerChip 8

ChipRate 3.84 MHz

ChipsPerSlot 2560

SlotsPerFrame 15
Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30
RF_R SourceR

TimeStep 1/(ChipRate*SamplesPerChip)

SlotTime

This is the test bench simulation time step

ChipsPerSlot*SamplesPerChip*TimeStep
This is the time duration of each slot
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FrameTime SlotTime*SlotsPerFrame
Meas_FMeasurement FMeasurement
Meas_R MeasR

Baseline Performance

e Test Computer Configuration
° Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
¢ Conditions
° Measurements made with default test bench settings.
° RF DUT is an RF system behavior component.
° The number of time points in one slot can be calculated by SamplesPerChip times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 y time points per slot = 20480
e Simulation times and memory requirements

3GPPFDD_UE_TX Slots Measured Simulation Time ADS Processes (MB)
Measurement (sec)
RF_Envelope 1 9 207
Power 1 7 205
ACLR 1 91 205
ACLR_ST 1 47 209
Occupied BW 1 9 212
CDP 1 101 211
PCDE 1 436 212
EVM 1 434 205

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and the RF DUT Circuit Envelope
simulation with the same signal and number of time points. For example, if the RF DUT performance with Circuit
Envelope simulation alone takes 2 hours and consumes 200 MB of memory (excluding the memory consumed by the
core ADS product), then add these numbers to the Baseline Performance numbers to determine the expected ADS
performance. This is valid only if the full memory consumed is from RAM. If RAM is less, larger simulation times may
result due to increased disk access time for swap memory usage.
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References

3GPPFDD_UE_TX Test Bench specific references:

1. 3GPP Technical Specification TS 25.211, "Physical channels and mapping of transport channels onto physical
channels (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25211-3a0.zi

2. 3GPP Technical Specification TS 25.212, "Multiplexing and Channel Coding (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25212-390.zi

3. 3GPP Technical Specification TS 25.213, "Spreading and modulation (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25213-370.zi

4. 3GPP Technical Specification TS 25.101, "UE Radio transmission and reception (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25_ series/25101-3a0.zi

5. 3GPP Technical Specification TS 34.121, "Terminal Conformance Specification, Radio Transmission and Reception
(FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/34 series/34121-380.zip

Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation documentation explains how to use
test bench windows and dialogs to perform analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation documentation explains how to set
up circuit envelope analysis parameters such as convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench Simulation documentation to learn how
to improve simulation speed.

3GPP FDD Base Station Receiver Test

3GPPFDD_BS_RX is the test bench for 3GPP FDD base station receiver testing. The test bench provides a way for
users to connect to an RF circuit device under test and determine its performance using pre-defined test bench
measurements. This test bench provides signal measurements for reference sensitivity level, dynamic range, adjacent
channel selectivity, and blocking and intermodulation characteristics.

The signal and the measurements are designed according to 3GPP Technical Specifications TS 25.104 and TS 25.141.
Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal Generator, Option 400 (3GPP
W-CDMA Firmware Option for the E4438C ESG Vector Signal Generator). Details regarding Agilent E4438C ESG are

included at the website http://www.agilent.com/find/esg.

This test bench includes a TX DSP section, an RF modulator, RF output source resistance, an RF DUT connection, RF
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receivers, and DSP measurement blocks as illustrated in the following figure. The generated test signal is sent to the
DUT.

WTE RF WTE Meas
Q Output Input
Meas Signal
TX | _gel AF RF Output RF RF Load Meas RF p-| DSP
DSP | gl Modulator  —M= Resistance |~ DUT |—| Resistance Receiver Measuremant
|

Receiver Wireless Test Bench Block Diagram

The 3GPPFDD_BS_RX test bench uses the uplink 12.2kbps reference measurement channel. One 12.2kbps DTCH
(dedicated transport channel) and one 2.4 kbps DCCH (dedicated control channel) are multiplexed into one 60 kbps
DPDCH (dedicated physical data channel). The 60kbps DPDCH and 15kbps DPCCH (dedicated physical control channel)
are I/Q multiplexed into one data stream using different spread factors (64 for DPDCH, 256 for DPCCH), then

scrambled with the specified scrambling code. The amplitude ratio of DPCCH/DPDCH is 0.7333 according to the
TS25.104 Annex A. All measurements provide BER results for DCCH and DTCH.

Test Bench Basics

A template is provided for this test bench.

3GPP FDD .
Design Informstion
]

Amplifier2

AGPPFDD BS RX Info

@ ENVELOPE

Envelope

[E WAR

3GPPFDD Base Station Receiver Test Bench

To access the template:
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1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_BS_RX_test, click OK; click left to place the template in
the schematic window.

An example design using this template is available; from the ADS Main window click File > Example Project >
WCDMA3G_RF_Verification_prj > 3GPPFDD_BS_RX_test .dsn.

The basics for using the test bench are:

e Connect to an RF DUT that is suitable for this test bench.

e CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values are typically accepted; if not,
set values based on your requirements.

e Activate/deactivate measurement(s) based on your requirements.

¢ Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.

Test Bench Details

The following sections provide details for setting up a test bench, setting measurement parameters for more control of
the test bench, simulation measurement displays, and baseline performance.

Open and use the template:

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_BS_RX_test, click OK ; click left to place the template in
the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is suitable for this test bench.
For general information regarding using certain types of DUTs, see Appendix A, RF DUT Limitations.
2. Set the Required Parameters .

 Note

Refer to 3GPPFDD BS RX for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the user as needed.

e Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data Flow simulation technology)
and the DUT (using Circuit Envelope simulation technology). Each technology requires its own simulation
time step with time-step coordination occurring in the interface between the technologies.
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CE_TimeStep defines the Circuit Envelope simulation time step to be used with this DUT. The CE_TimeStep
must be set to a value equal to or a submultiple of (less than) WTB_TimeStep; otherwise, simulation will
stop and an error message will be displayed.

The CE_TimeStep value is exported to the Choosing Analyses window in the Circuit Envelope Time Step
field when the user clicks OK in the Wireless Test Bench Setup window.

Note that WTB_TimeStep is not user-settable. Its value is derived from other test bench parameter values;
with default settings WTB_TimeStep=1/(3.84e6 x 8) sec. The value is displayed in the Data Display pages
as TimeStep.

WTB_TimeStep = 1/(ChipRate x SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during pulse forming.

e Set FSource, SourcePower, and FMeasurement.
° FSource defines the RF frequency for the signal input to the RF DUT.
° SourcePower defines the power level for FSource. SourcePower is defined as the average power during
the non-idle time of the signal.
° FMeasurement defines the RF frequency output from the DUT to be measured.
e MeasType specifies the type of measurement.
Pre-defined measurement settings (according to 3GPP specifications) are provided for signal power, AWGN
interference, CW interference, and modulated interference.

. Activate/deactivate ( YES / NO ) test bench measurements (refer to 3GPPFDD_BS RX ). At least one
measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters , Signal Parameters , and parameters
for each activated measurement. For details refer to Parameter Settings.
. The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block Diagram) uses FSource,
SourcePower ( Required Parameters ), MirrorSourceSpectrum ( Basic Parameters) , GainImbalance,
PhaseIlmbalance, I OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the specified source resistance
(SourceR) and with power (SourcePower) delivered into a matched load of resistance SourceR. The RF signal has
additive Gaussian noise power set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT set by the MeasR value
(50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays associated with the RF DUT input
to output characteristics.
The TX DSP block (shown in the block diagram in Receiver Wireless Test Bench Block Diagram) uses other Signal
Parameters.
More control of Circuit Envelope analysis can be achieved by setting Envelope controller parameters. These
settings include Enable Fast Cosim, which may speed the RF DUT simulation more than 10x. Setting these
simulation options is described in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
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7. To run a simulation, choose Simulation > Run in the Analog Design Environment main window.
For details, refer to R unning a Simulation in the Wireless Test Bench Simulation documentation.

8. Simulation results will appear in a Data Display window for each measurement. Simulation Measurement

Displays describes results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation documentation.

3GPPFDD_BS_RX

This section provides parameter information for Required Parameters, Basic Parameters, Signal Parameters, and

parameters for the various measurements.

3GPPFDD_BS_R¥

Description 3GPP FDD BS RX test
Library WTB

Class TSDF3GPPFDD_BS_RX
Derived From baseWTB_RX

Parameters

Name Description Default Sym

RequiredParameters

CE_TimeStep Circuit 1/3.84 MHz/8
envelope
simulation
time step

WTB_TimeStep Set
CE_TimeStep
< =
1/3.84e6/SamplesPerChip.
SamplesPerChip
is in Signal
Parameters
tab.

FSource Source carrier 1950 MHz

94

sec

Hz

Unit

real

real

Type

Range

(0, )

(0, )


http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+BS+RX#3GPPFDDBSRX-1231293
http://edocs.soco.agilent.com/display/ads2008/3GPPFDD+BS+RX#3GPPFDDBSRX-1231293

frequency

FMeasurement = Measurement
carrier
frequency

MeasurementInfcAvailable
Measurements
Each
measurement
has
parameters on
its
tab/category
below.

MeasType Measurement
type:
ReflLevel,
DynamicRange,
ACS, Blocking,

Intermod
BasicParameters
SourceR Source
resistance
SourceTemp Source
resistor
temperature
MeasR Measurement
resistance

MirrorSourceSpedditmor source
spectrum
about carrier?
NO, YES

MirrorMeasSpectidirror meas
spectrum
about carrier?
NO, YES

DUT_DelayBoundUT delay
bound

TestBenchSeed Random
number
generator
seed

SignalParameters
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1950 MHz

ReflLevel

50 Ohm

16.85

50 Ohm

NO

NO

10.0 usec

1234567

Hz

Ohm

Celsius

Ohm

sec
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real

enum

real

real

real

enum

enum

real

int

(0, )

(0, )

[-273.15, )

[10, 1.0e6]

(o,
(400.0/3840000)]

[0, o)



GainImbalance Gain
imbalance, Q
vs I

Phaselmbalance Phase
imbalance, Q
vs I

I_OriginOffset I origin offset

(percent)

Q_OriginOffset = Q origin offset
(percent)

IQ_Rotation IQ rotation

SamplesPerChip Samples per
chip

RRC_FilterLengthRRC filter chip
length

Secification
version:
Version
03_00,
Version
12_00,
Version 03_02

SpecVersion

RefLevelParameters

RefLevel_Wanted@ignta&msigral
power:
dbmtow(-121)
RefLevel

DynamicRangeParameters
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0.0

0.0

0.0

0.0

16

Version 12_00

dbmtow(-121)
ReflLevel

DynamicRange_WéaieekS isjgaltowdbmtow(-91)

power:
dbmtow(-91)
DynamicRange

DynamicRange

DynamicRange_AMWGHN Density =~ dbmtow(-73)/(Z.84MHz)

interference
power density:

dbmtow(-73)/(Z

DynamicRange
ACS_Parameters

ACS_WantedSignal@oteerr signal
power:
dbmtow(-115)

DynamicRange

.84MHz)

dbmtow(-115)
ACS
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dB

deg

deg

real

real

real

real

real

int

int

enum

real enum

real enum

real enum

real enum

)

)

)

)

(-OO, OO)

[2,

[1,

(0,

(0,

(0,

(0,

32]

1000]

)

)

)



ACS

ACS_ModFreqOffééddulated
channel
frequency
offset: plus
5MHz ACS,
minus 5MHz
ACS

ACS_ModPower Modulated
channel
power:
dbmtow(-52)
ACS

BlockingParameters

Blocking_Info = When

Advanced Design System 2008

plus 5MHz ACS

dbmtow(-52)
ACS

Blocking_ModFreqOffset

is +10 MHz /
-10 MHz, the
recommended

SamplesPerChip

(in Signal
Parameters
Tab) is 16.
Also, set
CE_TimeStep
equal to or
less than the
value

1/3.84e6/SamplesPerChip.

Blocking_Wanted®ignidBcsigamal
power:
dbmtow(-115)
Blocking

Blocking_ModFredfoffsédsted
channel
frequency
offset: plus
10MHz
Blocking,
minus 10MHz
Blocking

Blocking_ModPowéodulated
channel
power:
dbmtow(-40)

dbmtow(-115)
Blocking

plus 10MHz
Blocking

dbmtow(-40)
Blocking
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Hz

real enum

real enum

real enum

real enum

real enum

(_ool OO)

(0, )

(0, )

(_ool OO)

(0, )
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Blocking
IntermodParameters

Intermod_Info When
Intermod_ModF-eqOffset
is +20 MHz /

-20 MHz, the
recommended
SamplesPerChip
(in Signal
Parameters
Tab) is 32.
Also, set
CE_TimeStep
equal to or

less than the
value
1/3.84e6/SamplesPerChip.

Intermod_WantetiigbadPsigral dbmtow(-115) w real enum [0, o)
power: Intermod
dbmtow(-115)
Intermod

Intermod_CW_Fr€q6fiisebus plus 10MHz Hz real enum (-0, c0)
wave Intermod_CW
frequency
offset: plus
10MHz
Intermod_CW,
minus 10MHz
Intermod_CW

Intermod_CW_Pdvagrtinuous dbmtow(-48) w real enum (0, )
wave power: Intermod_CW
dbmtow(-48)
Intermod_CW

Intermod_ModFrét¢@ftdated plus 20MHz Hz real enum (o0, o)
channel Intermod_Mod
frequency
offset: plus
20MHz
Intermod_Mod,
minus 20MHz
Intermod_Mod

Intermod_ModPoMedulated dbmtow(-48) w real enum (0, c0)
channel Intermod_Mod
power:
dbmtow(-48)
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Intermod_Mod
MeasurementParameters

DisplayPages RX
measurement
display pages:
3GPPFDD_BS_RX_test
Table
3GPPFDD_BS_RX_test
Equations

FrameSetsMeasuBsts of 4 21
frames
measured

RAKE_PathDelay Path delay for 0

RAKE
(samples)
Pin Inputs
Pin Name
2 Meas_In
Pin Outputs
Pin Name
1 RF_Out

Parameter Settings

int [2, o]
int [0, 2559]
Description Signal Type

Test bench measurement timed
RF input from RF circuit

Description Signal Type

Test bench RF output to RF ' timed
circuit

More control of the test bench can be achieved by setting parameters on the Basic Parameters, Signal Parameters,
and measurements categories for the activated measurements. Parameters for each category are described in the

following sections.

 Note

For required parameter information, see Set the Required Parameters..

Basic Parameters
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1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise density in the RF output signal
to (k(SourceTemp+273.15)) Watts/Hz, where k is Boltzmann's constant.

3. MeasR defines the load resistance for the RF DUT output Meas signal into the test bench. This resistance loads
the RF DUT output; it is also the reference resistance for Meas signal power measurements.

4. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the generated RF signal before it is sent
to the RF DUT. Depending on the configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set this parameter to YES.

5. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in RF signal input to the test
bench (and output from the RF DUT). Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and measurement of the RF DUT
output signal requires that its RF envelope is not mirrored compared to the signal generated by the signal source
(before any mirroring is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for measurements on the
Meas_in signal in RX text benches and results in measurement on a signal with no spectrum mirroring.

6. TestBenchSeed is an integer used to seed the random number generator used with the test bench. This value is
used by all test bench random number generators, except those RF DUT components that use their own specific
seed parameter. TestBenchSeed initializes the random number generation. The same seed value produces the
same random results, thereby giving you predictable simulation results. To generate repeatable random output
from simulation to simulation, use any positive seed value. If you want the output to be truly random, enter the
seed value of 0.

7. DUT_DelayBound is the maximum time delay introduced by the DUT.

Signal Parameters

1. GainImbalance, Phaselmbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are used to add certain
impairments to the ideal output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance applied. The RF is given by:

Ver(t) = A{Vi(t)cos(o t) -gV(t)sin| o t+ %|;|

where A is a scaling factor that depends on the SourcePower and SourceR parameters specified by the user, VI (
t ) is the in-phase RF envelope, V Q ( t ) is the quadrature phase RF envelope, g is the gain imbalance

Gainlmbalance

g = 10 30

and, ® (in degrees) is the phase imbalance.
Next, the signal V RF ( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and Q_OriginOffset are then
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applied to the rotated signal. Note that the amounts specified are percentages with respect to the output rms
voltage. The output rms voltage is given by sqrt(2 x SourceR x SourcePower).

2. SamplesPerChip is used to set the number of samples in a chip.
The default value is set to 8 to display settings according to the 3GPP standard. It can be set to a larger value for
a simulation frequency bandwidth wider than 8 x 3.84 MHz. It can be set to a smaller value for faster simulation
times; however, this will result in lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is
larger than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 x 3.84 MHz).

3. RRC_FilterLength is used to set root raised-cosine (RRC) filter length in chips
The default value is set to 16 to transmit a 3GPP FDD uplink signal in time and frequency domains based on the
3GPP standard [4]. It can be set to a smaller value for faster simulation times; however, this will result in lower
signal fidelity.

4. SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12, or 2002-03.

RefLevel Parameters

RefLevel_WantedSignalPower is the RF_out power for the reference sensitivity level test. (MeasType = ReflLevel)

DynamicRange Parameters

1. DynamicRange_WantedSignalPower is the RF_out power for the dynamic range test. (MeasType =
DynamicRange)
2. DynamicRange_AWGN_Density is the interference additive white gaussian noise signal power density.

ACS Parameters

1. ACS_WantedSignalPower is the RF_out power for the adjacent channel selectivity test. (MeasType = ACS)

2. ACS_ModFreqOffset is the modulated adjacent channel signal frequency offset from the center frequency
(FSource) of the assigned channel.

3. ACS_ModPower is modulated adjacent channel signal power.

Blocking Parameters

1. Blocking_WantedSignalPower is the RF_out power for the blocking test. (MeasType = Blocking)

2. Blocking_ModFreqOffset is the unwanted modulated signal frequency offset (other than adjacent channel) from
the center frequency (FSource) of the assigned channel.

3. Blocking_ModPower is the unwanted modulated signal power.
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Intermod Parameters

1.
2.

Intermod_WantedSignalPower is the RF_out power for the intermodulation test. (MeasType = Intermod)
Intermod_CW_FreqOffset is the continuous wave frequency offset (un-modulated signal) interference from the
center frequency (FSource) of the assigned channel.

Intermod_CW_Power is the continuous wave interference power.

Intermod_ModFreqOffset is the unwanted modulated signal frequency offset from the center frequency (FSource)
of the assigned channel.

Intermod_ModPower is the unwanted modulated signal power.

Measurement Parameters

DisplayPages provides Data Display page information for this measurement. It cannot be changed by the user.

. FrameSetsMeasured is the number of frame sets to be measured. One frame set consists of four radio frames;

one radio frame is 10 msec.
RAKE_PathDelay specifies the delay for the signal starting point. If RAKE_PathDelay=0, the delay is
automatically searched; if set to a non-zero integer, the receiver uses this value for the signal starting point.

Simulation Measurement Displays

After running the simulation, results are displayed in the Data Display pages for each measurement. Each Data
Display includes tables and equations pages. Simulation results include the BER of DTCH (dedicated transport
channel), DCCH (dedicated control channel) and DPDCH (dedicated physical data channel), and required parameters
to set up the test benches. Meas BER results are obtained by passing the signals through a DUT.

RF source power, RF source frequency, DUT output frequency, source output resistance, and DUT output resistance
are also displayed.

All tests require DTCH and DCCH BER performance, which cannot exceed 0.001.

i)

Note

Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless Test
Benches.

Reference Sensitivity Level

The reference sensitivity level (defined in section 7.2 of TS25.104 [4]) is measured when MeasType is set to RefLevel.
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Test conditions are:
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BS Reference Sensitivity Level (dBm)

-121 dBm

BER

BER shall not exceed 0.001

The following figure shows reference sensitivity level test results.

realiRF_FSaurceli{l MHZ realiRF_Power_dB real(RF_R)
T9570.000 B e W] 50.00
realieas_FMeasurement)/(1 MHz) realiMeas_R) EbMO_RF_dH
-~ a0, 000 50,000 .

Meas BER Results

Meas_BER.DTCH_BER

Meas_BER.DCCH_BER

oo

(KR

Meas_BER.DPDCH_BER
oo

AGPP Specification TS 25104 (2000-12) section 72

5pecification requirements
The DTCH and DCCH BER shall not exceed 0.001

aecording to TS 25.104.

Reference Sensitivity Level Test Results

Dynamic Range

The dynamic range (defined in section 7.3 of TS25.104 [4]) is measured when MeasType is set to DynamicRange. Test

conditions are:

Parameter
Wanted signal

Interfering AWGN signal

Level
-91
-73

Dynamic Range Test Results shows the dynamic range test results.
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real{RF_FSourceiil MHz real(RF_Power_dBm} real{RF_FR)
T950.000 -G1.000 a0.000
realiMeas_FMeasurementil MHZ realiMeas_R) EbrMO_RF_dB
T950.000 S0.000 36454
Meas BER Results
Meas_BER.DTCH_BER Meas_BER.DCCH_BER Meas_BER.DFDCH_BER
0.000 I 0003

AGPP Specification TS 25 104 (2000-12) section 73

Specification requirements Test results

The DTCH and DCCH BER shall not exceed 0001
acecording to TS 25.104, Passed

Dynamic Range Test Results

Adjacent Channel Selectivity

Adjacent channel sensitivity (defined in section 7.4 of TS25.104 [4]) is measured when MeasType is set to ACS. Test

conditions are:

Parameter Level Unit
Wanted signal -115 dBm
Interfering signal -52 dBm
MHz

Fuw (Modulated) 5

The interfering signal is a modulated uplink signal with 1 DPCCH + 1 DPDCH, where the DPDCH rate is 960kbps. Fuw
is the frequency offset of the modulated signal. The following figure shows the adjacent channel sensitivity results.
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realiRF_FSaurce)il MHZ) real(RF_Power_dBm) realiRF_R)
T950.000 AT5000 5000
realMeas_FMeasurementiil MHZ) real(Meas_R) EBMNO_RF_dB |
- THaU U0 B A0.Oon 12.4541
Meas BER Results
Meas_BER.DTCH_BER Meas_BER.DCCH_BER Meas_BER.OPDCH_BER
B B 1000 B B oo B 0.002

AGPP Specification TS 25.104 (2000-12) section 74

Specification requirements Test results

The DTCH and DCCH BER shall not exceed 0001

acecording to TS 25.104, Passed

Adjacent Channel Sensitivity Test Results

Blocking Characteristics

Blocking characteristics (defined in section 7.5 in TS25.104[4]) are tested when MeasType is set to Blocking. Test
conditions are:

Interfering Signal Level Wanted Signal Level Minimum Offset of Type of Interfering Signal
Interfering Signal
-40dBm -115dBm +10MHz WCDMA signal with one
code

The following figure shows the blocking characteristics test results.
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realiRF_FSourceii(l MHZ) real(RF_Power_dBm) realiRF_R)
T950.000 -T15.000 a0.00
realiMeas_FMeasurerment) /{1 MHz) real(Meas_R) EbMO_RF_dB |
-~ T950.000 - LA ]} T T2 459
Meas BER Results
Meas_BER.DTCH_BER Meas_BER DCCH_BER Meas_BER.DPDLH_BER
~ B A1) B — oo B 0.003

AGPP Specification TS 25.104 (2000-12) section 7.5

Specification requirements Test results

The PTCH and DCCH BER shall not exceed 00001

aceording to TS 25.104, Passed

Blocking Characteristics Test Results

Intermodulation Characteristics

Intermodulation characteristics (defined in section 7.6 in TS25.104[4]) are tested when MeasType is set to Intermod.
Test conditions are:

Interfering Signal Level Offset Type of Interfering Signal
-48 dBm +10 MHz CW signal
-48 dBm +20 MHz WCDMA signal with one code

In the RF channel, there are two intermodulation response signals that have a specific frequency relationship to the
requisite signal:

¢ By default, the continuous wave interference has a +10 MHz frequency offset from the central carrier frequency;

its power is -48 dBm.
¢ By default, the modulated interfering signal has a +20 MHz offset from the center carrier frequency; its power is

-48 dBm/3.84 MHz.

The following figure shows intermodulation characteristics test results.
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reallRF_FSource)(1 MHz) real(RF_Power dBm) real(RF_R)
T950.000 -115.000 50.000
realiMeas FMeasurement)/(1 MHz) real(eas R EbND RF dBE
T950.000 S0.000 12454

Meas BER Results

Meas BER.DTCH_BER

Meas BER DCCH_BER

Wieas_BER.DPDCH_BER

(.000

0.0oo

0. 0o

AGPP Specification TS 25104 {2000-12) section [ls:

Specification requirements

The DTCH and DCCH BER shall not exceed 00001

according to TS 25104,

Intermodulation Characteristics Test Results

Test Bench Variables for Data Displays

Test results

Passed

The following table identifies the reference variables used to set up this test bench.

Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display

Data Display Parameter

Spec_Version
RF_FSource
RF_R
RF_SourceTemp

RF_Power_dBm

ChipRate

SpecVersion
FSource
SourceR

SourceTemp

Equation with Test Bench Parameters

30 + 10 log(WantedSignalPower),

where WantedSignalPower =
RefLevel_WantedSignalPower, or
DynamicRange_WantedSignalPower, or
ACS_WantedSignalPower, or
Blocking_WantedSignalPower, or
Intermod_WantedSignalPower, according to MeasType
setting.

3.84MChips/Second
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SlotTime 0.667ms

FrameTime 10ms

TimeStep 1/(3.84e6*SamplesPerChip)
Meas_FMeasurement FMeasurement

Meas_R MeasR

FrameNum FramSetsMeasured * 4

AWGN_Density 30 + 10 log(DynamicRange_AWGN_Density),

when MeasType = DynamicRange

ModFreq FSource + ModFreqOffset,
where ModFreqOffset = ACS_ModFreqOffset, or
Blocking_ModFreqOffset, or Intermod_ModFreqOffset,
according to MeasType = ACS, Blocking, or Intermod.

ModePower_dBm 30 + 10 log (ModPower),
where ModPower = ACS_ModPower, or
Blocking_ModPower or Intermod_ModPower,
according to MeasType = ACS, Blocking, or Intermod.

CWFreq FSource + Intermod_CW_FreqOffset,
when MeasType = Intermod

CWPower_dBm 30 + 10 log(Intermod_CW_Power),
when MeasType = Intermod

Baseline Performance

e Test Computer Configuration
° Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
¢ Conditions
° Measurements made with default test bench settings.
° RF DUT is an RF system behavior component.
° The number of time points in one slot can be calculated by SamplesPerChip times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
1 FrameSet = 4 Frames
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 y time points per slot = 20480
e Simulation times and memory requirements.

Measurement FrameSets Measured Simulation Time ADS Processes
(sec) (MB)
RefLevel 21 1858 105
DynamicRange 21 1941 106
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ACS 21 2642 107
Blocking 21 2533 106
Intermod 21 2440 107

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and the RF DUT Circuit Envelope
simulation with the same signal and number of time points. For example, if the RF DUT performance with Circuit
Envelope simulation alone takes 2 hours and consumes 200 MB of memory (excluding the memory consumed by the
core ADS product), then add these numbers to the Baseline Performance numbers to determine the expected ADS
performance. This is valid only if the full memory consumed is from RAM. If RAM is less, larger simulation times may
result due to increased disk access time for swap memory usage.

References

1. 3GPP Technical Specification TS 25.211, "Physical channels and mapping of transport channels onto physical
channels (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25211-3a0.zi

2. 3GPP Technical Specification TS 25.212, "Multiplexing and Channel Coding (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25212-390.zip

3. 3GPP Technical Specification TS 25.213, "Spreading and modulation (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25213-370.zip

4. 3GPP Technical Specification TS 25.104, "UTRA (BS) FDD; Radio transmission and Reception" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25104-3a0.zip

5. 3GPP Technical Specification TS 25.141, "Base station conformance testing (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25 series/25141-390.zip

Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation documentation explains how to use
test bench windows and dialogs to perform analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation documentation explains how to set
up circuit envelope analysis parameters such as convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench Simulation documentation to learn how
to improve simulation speed.

3GPP FDD User Equipment Receiver Test
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3GPPFDD_UE_RX is the test bench for 3GPP FDD user equipment receiver testing. The test bench provides a way for
users to connect to an RF circuit device under test and determine its performance using pre-defined test bench
measurements. This test bench provides signal measurements for reference sensitivity level, maximum input level,
adjacent channel selectivity, and blocking and intermodulation characteristics.

The signal and the measurements are designed according to 3GPP Technical Specifications TS 25.101 and TS 34.121.
Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal Generator, Option 400 (3GPP
W-CDMA Firmware Option for the E4438C ESG Vector Signal Generator). Details regarding Agilent E4438C ESG are
included at the website http://www.agilent.com/find/esg.

This test bench includes a TX DSP section, an RF modulator, RF output source resistance, an RF DUT connection, RF
receivers, and DSP measurement blocks as illustrated in the following figure. The generated test signal is sent to the
DUT.

WTEB RF WTE Meas
0 Output Input
Meas Signal
TX — - RF RF Output RF RF Load Meas RF - DSP
DSP | g Modulator  —M= Resistance |~ DUT |—| Resistance Receiver Measurement

Receiver Wireless Test Bench Block Diagram

The 3GPPFDD_UE_RX test bench uses the downlink 12.2kbps reference measurement channel. One 12.2kbps DTCH
(dedicated transport channel) and one 2.4kbps DCCH (dedicated control channel) are multiplexed into one 60kbps
DPCH (dedicated physical data channel). The signal source includes one DPCH, one PCCPCH (primary common control
physical channel), one PSCH (primary synchronization channel), one SSCH (secondary synchronization channel), one
CPICH (common pilot channel), and one PICH (page indication channel).

In user equipment receiver measurements except maximum input level, channels are set according to the following
table.

Downlink Physical Channels Transmitted During a Connection

Physical Channel Power
P-CPICH P-CPICH_Ec / DPCH_Ec = 7dB
P-CCPCH P-CCPCH_Ec / DPCH_Ec = 5dB
SCH SCH_Ec / DPCH_Ec = 5dB
PICH PICH_Ec / DPCH_Ec = 2dB
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DPCH Test dependent power

SCH power is divided equally between primary and secondary synchronous channels, so the P-SCH_Ec/(DPCH_Ec =
S-SCH_Ec*DPCH_Ec) = 2dB.

For the maximum input level measurement, the OCNS interference is set to the power necessary to achieve the
required DPCH_Ec/I or of -19dB. The gain of the other channels remain the same.

All measurements provide BER results for DCCH and DTCH.

Test Bench Basics

A template is provided for this test bench.

AGFP FOD
Design Information
- .

3GPPFDD_UE RX_ Info Armplifier2

| @ | ENVELOPE I

—>

Y

Envelope == JGPP
EET T test
VAR IGPPFOD_UE_RX

3GPPFDD User Equipment Receiver Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_UE_RX_test, click OK; click left to place the template in
the schematic window.

An example design using this template is available; from the ADS Main window click File > Example Project >
WCDMA3G_RF_Verification_prj > 3GPPFDD_UE_RX_test .dsn.

The basics for using the test bench are:
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e Connect to an RF DUT that is suitable for this test bench.

e CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values are typically accepted; if not,
set values based on your requirements.

e Activate/deactivate measurement(s) based on your requirements.

e Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.

Test Bench Details

The following sections provide details for setting up a test bench, setting measurement parameters for more control of
the test bench, simulation measurement displays, and baseline performance.

Open and use the template:

1. In an Analog/RF schematic window select Insert > Template.
2. In the Insert > Template dialog box, choose 3GPPFDD_UE_RX_test, click OK; click left to place the template in
the schematic window.

The test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is suitable for this test bench.
For general information regarding using certain types of DUTs, see Appendix A, RF DUT Limitations.
2. Set the Required Parameters.

 Note

Refer to 3GPPFDD UE RX for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the user as needed.

e Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent Ptolemy Data Flow simulation technology) and
the DUT (using Agilent Circuit Envelope simulation technology). Each technology requires its own simulation
time step with time-step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with this DUT. The CE_TimeStep
must be set to a value equal to or a submultiple of (less than) WTB_TimeStep; otherwise, simulation will
stop and an error message will be displayed.
The CE_TimeStep value is exported to the Choosing Analyses window in the Circuit Envelope Time Step
field when the user clicks OK in the Wireless Test Bench Setup window.
Note that WTB_TimeStep is not user-settable. Its value is derived from other test bench parameter values;
with default settings WTB_TimeStep=1/(3.84e6 x 8) sec. The value is displayed in the Data Display pages
as TimeStep.

WTB_TimeStep = 1/(ChipRate x SamplesPerChip)
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where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during pulse forming.

e Set FSource, SourcePower, and FMeasurement.
° FSource defines the RF frequency for the signal input to the RF DUT.
° SourcePower defines the power level for FSource. SourcePower is defined as the average power during
the non-idle time of the signal.
° FMeasurement defines the RF frequency output from the DUT to be measured.
e MeasType specifies the type of measurement.
Pre-defined measurement settings (according to 3GPP specifications) are provided for Ior_Power,
DPCH_Ec_2_Ior, CW interference, and modulated interference.

3. Activate/deactivate ( YES / NO ) test bench measurements (refer to 3GPPFDD UE RX). At least one
measurement must be enabled.

4. More control of the test bench can be achieved by setting Basic Parameters, Signal Parameters, and parameters
for each measurement. For details refer to Parameter Settings.

5. The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block Diagram) uses FSource,
SourcePower ( Required Parameters ), MirrorSourceSpectrum ( Basic Parameters), GainImbalance,
PhaseImbalance, I OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).

The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource), with the specified source resistance
(SourceR) and with power (SourcePower) delivered into a matched load of resistance SourceR. The RF signal has
additive Gaussian noise power set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).

Note that the Meas_in point of the test bench provides a resistive load to the RF DUT set by the MeasR value

(50 Q default) ( Basic Parameters ).

The Meas signhal contains linear and nonlinear signal distortions and time delays associated with the RF DUT input
to output characteristics.

The TX DSP block (shown in the block diagram in Receiver Wireless Test Bench Block Diagram) uses other Signal
Parameters.

6. More control of the Circuit Envelope simulation of the RF DUT is achieved by selecting Options in the Choosing
Analysis window. These advanced options include enabling Automatic Behavioral Modeling (which may speed up
the RF DUT simulation by over 10X), and setting Circuit Envelope parameters. Setting these simulations options
is described in Setting Automatic Behavioral Modeling Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.

7. To run a simulation, choose Simulation > Run in the Analog Design Environment main window.

For details, refer to R unning a Simulation in the Wireless Test Bench Simulation documentation.

8. Simulation results will appear in a Data Display window for each measurement. Simulation Measurement
Displays describes results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation documentation.

3GPPFDD_UE_RX
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This section provides parameter information for Required Parameters, Basic Parameters, Signal Parameters, and

parameters for the various measurements.

B = IGFR

cE=| U

= = O D L1
ALl

ZGPPFDD_UE Rx

Description 3GPP FDD UE RX BER
Library WTB

Class TSDF3GPPFDD_UE_RX
Derived From baseWTB_RX

Parameters

Name Description Default
RequiredParameters

CE_TimeStep Circuit
envelope
simulation
time step

1/3.84 MHz/8

WTB_TimeStep Set
CE_TimeStep
< =
1/3.84e6/SamplesPerChip.
SamplesPerChip
is in Signal
Parameters
tab.

FSource Source carrier 2140 MHz
frequency

FMeasurement = Measurement 2140 MHz
carrier
frequency

MeasurementInfcAvailable
Measurements
Each
measurement
has
parameters on

Sym
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Hz

Hz

Unit

real

real

real

Type

Range

(0, )

(0, )

(0, )
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its
tab/category
below.

MeasType Measurement | ReflLevel enum
type:
ReflLevel,
MaxLevel,
ACS, Blocking,
Intermod

BasicParameters

SourceR Source 50 Ohm Ohm real (0, o)
resistance

SourceTemp Source 16.85 Celsius real [-273.15, o)
resistor
temperature

MeasR Measurement 50 Ohm Ohm real [10, 1.0e6]
resistance

MirrorSourceSpedditnor source NO enum
spectrum
about carrier?
NO, YES

MirrorMeasSpectiirror meas NO enum
spectrum
about carrier?
NO, YES

DUT_DelayBoundUT delay 10.0 usec sec real [O,
bound (400.0/3840000)]

TestBenchSeed Random 1234567 int [0, o0)
number
generator
seed

SignalParameters

GainImbalance @ Gain 0.0 dB real (-o0, )
imbalance, Q
vs I

PhaseImbalance Phase 0.0 deg real (-c0, )
imbalance, Q
vs 1

I_OriginOffset I origin offset | 0.0 real (-00, )
(percent)

Q_OriginOffset = Q origin offset ' 0.0 real (-o0, )
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(percent)
IQ_Rotation IQ rotation 0.0 deg real (-c0, )

SamplesPerChip Samples per 8 S int [2, 32]
chip

RRC_FilterLengthRRC filter 16 int [1, 1000]
length (chips)

SpecVersion Secification Version 12_00 enum
version:
Version
03_00,
Version
12_00,
Version 03_02

RefLevelParameters

RefLevel_Ior_Pcovier power: Based on w real enum [0, )
Based on FSource
FSource RefLevel
ReflLevel,

(Band I)
dbmtow(-106.7)
ReflLevel,

(Band II)
dbmtow(-104.7)
ReflLevel,

(Band III)
dbmtow(-103.7)
ReflLevel

RefLevel _DPCH__BXPQHI@c to -10.3dB dB real enum (-o0, -10.3]
Ior value: RefLevel
-10.3dB
ReflLevel

MaxLevelParameters

MaxLevel_Ior_Poleerpower: dbmtow(-25) w real enum (0, c0)
dbmtow(-25) MaxLevel
MaxLevel

MaxLevel _DPCH_[BBCH ¥ to -19dB dB real enum (-o0, -10.3]
Ior value: MaxLevel
-19dB
MaxLevel

ACS_Parameters

ACS_Ior_Power Ior power: dbmtow(-92.7) w real enum (0, ™)
dbmtow(-92.7) ACS
ACS
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ACS_ModFreqOfféétdulated

ACS_ModPower
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Ior value:
-10.3dB ACS

channel
frequency
offset: plus
5MHz ACS,
minus 5MHz
ACS

Modulated
channel ACS
power:

dbmtow(-52)

ACS

BlockingParameters

Blocking_Info

When
Blocking_ModFreqOffset
is +10 MHz /
-10 MHz, the
recommended
SamplesPerChip
(in Signal
Parameters
Tab) is 16.
Also, set
CE_TimeStep
equal to or

less than the
value

1/3.84e6/SamplesPerChip.

Blocking_lIor_Pcvier power: Based on

Based on FSource
FSource Blocking
Blocking,

(Band I)
dbmtow(-103.7)
Blocking,

(Band II)
dbmtow(-101.7)
Blocking,

(Band III)
dbmtow(-100.7)
Blocking

Blocking_DPCH_ E2PQHIdc to -10.3dB

Ior value: Blocking

-10.3dB ACS

plus 5MHz ACS

dbmtow(-52)

dB

Hz

dB

117

real enum
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real enum
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real enum
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(0, )
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-10.3dB
Blocking

Blocking_ModFretylofsédted plus 10MHz Hz real enum (-c0, )
channel Blocking
frequency
offset: plus
10MHz
Blocking,
minus 10MHz
Blocking, plus
15MHz
Blocking,
minus 15MHz
Blocking

Blocking_ModPowéodulated dbmtow(-56) w real enum (0, )
channel 10MHz
power: Blocking
dbmtow(-56)
10MHz
Blocking,
dbmtow(-44)
15MHz
Blocking

IntermodParameters

Intermod_Info When
Intermod_ModF-eqOffset
is +20 MHz /

-20 MHz, the
recommended
SamplesPerChip
(in Signal
Parameters
Tab) is 32.
Also, set
CE_TimeStep
equal to or

less than the
value
1/3.84e6/SamplesPerChip.

Intermod_Ior_Poleerpower: Based on w real enum [0, )
Based on FSource
FSource Intermod
Intermod,
(Band I)
-103.7 dBm
Intermod,
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(Band II)
-101.7 dBm
Intermod,
(Band III)
-100.7 dBm
Intermod

Intermod_DPCH_[BECP K to

Ior value:
-10.3dB
Intermod

Intermod_CW_Fr€q6ffiisabus

wave
frequency
offset: plus
10MHz

Intermod_CW,
minus 10MHz
Intermod_CW

Intermod_CW_Pdvoatinuous

wave power:

dbmtow(-46)
Intermod_CW

Intermod_ModF -&4@xftdated

channel
frequency
offset: plus
20MHz

Intermod_Mod,
minus 20MHz
Intermod_Mod

Intermod_ModPoMedulated

channel
power:

dbmtow(-46)
Intermod_Mod

MeasurementParameters

DisplayPages

RX

measurement
display pages:

Advanced Design System 2008

-10.3dB
Intermod

plus 10MHz
Intermod_CW

dbmtow(-46)
Intermod_CW

plus 20MHz
Intermod_Mod

dbmtow(-46)
Intermod_Mod

3GPPFDD_UE_RX

Tables

3GPPFDD_UE_RX

Equations

FrameSetsMeasuBats of 4

frames
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Hz
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real enum

real enum

real enum

real enum
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(_ool OO)

(0, )

(_ool 00)

(0, )

[2, )



Advanced Design System 2008

measured
RAKE_PathDelay Path delay for 0 int [0, 2559]
RAKE
(samples)
Pin Inputs
Pin Name Description Signal Type
2 Meas_In Test bench measurement timed
RF input from RF circuit
Pin Outputs
Pin Name Description Signal Type
1 RF_Out Test bench RF output to RF ' timed

circuit

Parameter Settings

More control of the test bench can be achieved by setting parameters on the Basic Parameters, Signal Parameters,
and measurements categories for the activated measurements. Parameters for each category are described in the
following sections.

 Note

For required parameter information, see Set the Required Parameters.

Basic Parameters

1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise density in the RF output signal
to (k(SourceTemp+273.15)) Watts/Hz, where k is Boltzmann's constant.

3. MeasR defines the load resistance for the RF DUT output Meas signal into the test bench. This resistance loads
the RF DUT output; it is also the reference resistance for Meas signal power measurements.

4. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the generated RF signal before it is sent

to the RF DUT. Depending on the configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set this parameter to YES.

5. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in RF signal input to the test
bench (and output from the RF DUT). Depending on the configuration and number of mixers in the RF DUT, the

signal at its output may be mirrored compared to the signal generated by the signal source (before any mirroring

is done because of the MirrorSourceSpectrum setting). Proper demodulation and measurement of the RF DUT
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output signal requires that its RF envelope is not mirrored compared to the signal generated by the signal source
(before any mirroring is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for measurements on the
Meas_in signal in RX text benches and results in measurement on a signal with no spectrum mirroring.

6. TestBenchSeed is an integer used to seed the random number generator used with the test bench. This value is
used by all test bench random number generators, except those RF DUT components that use their own specific
seed parameter. TestBenchSeed initializes the random number generation. The same seed value produces the
same random results, thereby giving you predictable simulation results. To generate repeatable random output
from simulation to simulation, use any positive seed value. If you want the output to be truly random, enter the
seed value of 0.

7. DUT_DelayBound is the maximum time delay introduced by the DUT.

Signal Parameters

1. GainImbalance, Phaselmbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are used to add certain
impairments to the ideal output RF signal. Impairments are added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance applied. The RF is given by:

VRFI;E.‘] = A—Lvﬂt'fﬂ“kﬂ f'—gV@tuml\m 4+ FSE@..

where A is a scaling factor that depends on the SourcePower and SourceR parameters specified by the user, VI (
t ) is the in-phase RF envelope, V Q ( t ) is the quadrature phase RF envelope, g is the gain imbalance

Gainlmbalance
20
g =10

and, © (in degrees) is the phase imbalance.

Next, the signal V RF ( t) is rotated by IQ_Rotation degrees. The I_OriginOffset and Q_OriginOffset are then
applied to the rotated signal. Note that the amounts specified are percentages with respect to the output rms
voltage. The output rms voltage is given by sqrt(2 x SourceR x SourcePower).

2. SamplesPerChip is used to set the number of samples in a chip.
The default value is set to 8 to display settings according to the 3GPP standard. It can be set to a larger value for
a simulation frequency bandwidth wider than 8 x 3.84 MHz. It can be set to a smaller value for faster simulation;
however, this will result in lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 x 3.84 MHz).

3. RRC_FilterLength is used to set root raised-cosine (RRC) filter length in humber of chips.
The default value is set to 16 to transmit a 3GPP FDD downlink signal in time and frequency domains based on
the 3GPP standard [4]. It can be set to a smaller value for faster simulation times; however, this will result in
lower signal fidelity.

4. SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12 and 2002-03.
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RefLevel Parameters

1. RefLevel_lor_Power is the RF_out power for the reference sensitivity level test (MeasType = ReflLevel). If Based
on FSource ReflLevel is selected, RefLevel_Ior_Power will be set according to the Operating Band specified by
FSource (see the following table). If FSource does not belong to any Operating Band, the nearest Operating Band
will be used to determine RefLevel Ior_ Power.

UTRA FDD Frequency Bands and Ior for Reference Sensitivity Test

Operating Band DL Frequencies, UE Receiver RefLevel_Ior_Power
(FSource)
I 2110 - 2170 MHz -106.7 dBm
II 1930 - 1990 MHz -104.7 dBm
II1 1805 - 1880 MHz -103.7 dBm

2. ReflLevel_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over I or power for the reference sensitivity level test.

MaxLevel Parameters

1. MaxLevel_Ior_Power is the RF_out power for the maximum input level test. (MeasType = MaxLevel)
2. MaxLevel_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over I or power for the maximum input level test.

ACS Parameters

1. ACS_Ior_Power is the RF_out power for the adjacent channel selectivity test. (MeasType = ACS)
2. ACS_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over I or power for the adjacent channel selectivity test.
3. ACS_ModFreqOffset is the modulated adjacent channel signal frequency offset from the center frequency

(FSource) of the assigned channel.
4. ACS_ModPower is the modulated adjacent channel signal power.

Blocking Parameters

1. Blocking_Ior_Power is the RF_out power for the blocking test (MeasType = Blocking). If Based on FSource
Blocking is selected, Blocking_Ior_Power will be set according to the Operating Band specified by FSource (see
the following table). If FSource does not belong to any Operating Band, the nearest Operating Band will be used

to determine Blocking_Ior_Power.

UTRA FDD Frequency Bands and Ior for Blocking Test
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Operating Band DL Frequencies, UE Receiver Blocking_Ior_Power
(FSource)
I 2110 - 2170 MHz -103.7 dBm
II 1930 - 1990 MHz -101.7 dBm
III 1805 - 1880 MHz -100.7 dBm

2. Blocking_DPCH_Ec_2_1Ior is the ratio of DPCH chip energy over I or power for the blocking test.

3. Blocking_ModFreqOffset is the unwanted modulated signal frequency offset (other than adjacent channel) from
the center frequency (FSource) of the assigned channel.

4. Blocking_ModPower is the unwanted modulated signal power.

Intermod Parameters

1. Intermod_Ior_Power is the RF_out power for the intermodulation test (MeasType = Intermod). If Based on
FSource Intermod is selected, Intermod_Ior_Power will be set according to the Operating Band specified by
FSource (see the following table). If FSource does not belong to any Operating Band, the nearest Operating Band
will be used to determine Intermod_Ior_Power.

UTRA FDD Frequency Bands and Ior for Intermodulation Test

Operating Band DL Frequencies, UE Receiver Intermod_Ior_Power
(FSource)
I 2110 - 2170 MHz -103.7 dBm
II 1930 - 1990 MHz -101.7 dBm
II1 1805 - 1880 MHz -100.7 dBm

2. Intermod_DPCH_Ec_2_1Ior is the ratio of DPCH chip energy over I or power for the intermodulation test.

3. Intermod_CW_FreqOffset is the frequency offset of the continuous wave (un-modulated signal) interference from
the center frequency (FSource) of the assigned channel.

4. Intermod_CW_Power is the continuous wave interference power.

5. Intermod_ModFreqOffset is the unwanted modulated signal frequency offset from the center frequency (FSource)
of the assigned channel.

6. Intermod_ModPower is the unwanted modulated signal power.

Measurement Parameters

1. DisplayPages provides Data Display page information for this measurement. It cannot be changed by the user.

2. FrameSetsMeasured is the number of frame sets to be measured. One frame set consists of four radio frames;
one radio frame is 10 msec.

3. RAKE_PathDelay specifies the delay for the signal starting point. If RAKE_PathDelay=0, the delay is
automatically searched; if set to a non-zero integer, the receiver uses this value for the signal starting point.
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Simulation Measurement Displays

After running the simulation, results are displayed in the Data Display pages for each measurement. Each Data
Display includes tables and equations pages. Simulation results include the BER of DTCH (dedicated transport
channel), DCCH (dedicated control channel) and DPDCH (dedicated physical data channel), and required parameters
to set up the test benches. Meas BER results are obtained by passing the signals through a DUT.

The DPCH chip energy, denoted by DPCH_Ec, is also displayed, as well as RF source frequency, DUT output frequency,
source output resistance, and DUT output resistance.

All tests require DTCH and DCCH BER performance, which cannot exceed 0.001.

 Note

Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless Test
Benches.

Reference Sensitivity Level

The reference sensitivity level (defined in section 7.2 of TS25.104 [4]) is measured when MeasType is set to RefLevel.
Test conditions are:

Parameter Unit Level
DPCH_Ec dBm/3.84MHz -117
Tor dBm/3.84MHz -106.7

The DPCH_Ec_2_Ior is -10.3dB under these conditions. The following figure shows reference sensitivity level test
results.
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reallRF _FSourcelil MHz) reallRF_R) realilor_Power_dBrm)
2740000 50,000 -T0E 700
reallMeas_Fheasurement)i1 MHzZ) reallMeas_R) DPCH_Ec_dBm
2730000 L0000 117000
EbMO_RF_dB
TEED3
Meas BER Results
DTCH_AverageBER DCCH_AverageBER DPCH_AverageBER
.00 .00 2 053E-4
AGPP specification TS 25101 (2000-12)  Section 7.2
Specification requirements Test results
The DTCH and DECH BER shall not excead 0.001 Passed

according ta TS 25.101

Reference Sensitivity Level Test Results

Maximum Input Level

The maximum input level (defined in section 7.4 of TS25.101 [4]) is measured when MeasType is set to MaxLevel.

Test conditions are:

Parameter
DPCH_Ec/Ior

Ior

Unit
dB
dBm/3.84MHz

The following figure shows the maximum input level test results.
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reallRF _FSource)il MHz) reallRF_R) real(lor_Poswer_dBm)
3 i) =000 -25.000
reallMeas_FMeasurement)i1 MHZ) reallieas _R) DPCH_Ec_dBm
HA0no0 S0.000 -4 000
EbMO_RF_dB
=R
Meas BER Results
DTCH_AverageBER DiZCH_AverageBER DPCH_AverageBER
.00 0.000 .00
AGPP Specification TS 25101 (2000-12)  Section 7 4
Specification requirements Test results
The DTCH and DCCH BER =shall not exceed 0.001 Passed

according to TS 25101

Maximum Input Level Test Results

Adjacent Channel Selectivity

The adjacent channel sensitivity (defined in section 7.5 of TS25.101 [4]) is measured when MeasType is set to ACS.

Test conditions are:

Parameter
DPCH_Ec
Tor
Ioac (modulated)

Fuw (offset)

The I oac (modulated) signal consists of 16 dedicated data channels. F uw is the frequency offset of the modulated

Unit
dBm/3.84MHz
dBm/3.84MHz
dBm/3.84MHz

MHz

-103
-92.7
-52

+5

signal. The following figure shows the adjacent channel sensitivity test results.

126

Level



Advanced Design System 2008

reasllRF_FSource)il MHZ) resl(RF_R) reslllor_Power_dBm)
21401000 S0 000 -52700
realiMeas_FMeasurement)i1 MHz) real(ieas R DPCH_Ec_dBm
21401000 0000 -T05.000
EbMO_RF_dB
30693
Meas BER Results
DTCH_AverageBER OCCH_AverageBER DPCH_AverageBER
11 700 {000 [Aauln]

AGPP Specification TS 25101 (2000-12) Section 7.5
Specification requirements Test results
The DTCH and DCCH BER shall not excead 00004 Passed

according to TS 25104

Adjacent Channel Sensitivity Test Results

Blocking Characteristics

The blocking characteristics (defined in section 7.6 of TS25.101 [4]) are tested when MeasType is set to Blocking. Test
conditions are:

Parameter Unit Test Case 1 Test Case 2
DPCH_Ec dBm/3.84MHz -114 -114
Tor dBm/3.84MHz -103.7 -103.7
Iblocking (modulated) dBm/3.84MHz -56 -44
Fuw (offset) MHz +10 or 10 +15

I blocking (modulated) consists of common channels and 16 dedicated data channels, and the frequency offset is F

uw.

The following figure shows the blocking characteristics test results.
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reallRF_FSource)il MHz) reallRF_R) realllor_Power_dBm)
2740000 S0.000 -T03.700
realiMeas_Fhleazurement)i1 MHz) realMeasz_F) DPCH_Ec_dBm
2740000 =0.00a -T14.000
EbMO_RF_cB
T E93
Meas BER Results
DTCH_AverageBER DCCH_AverageBER DPCH_AverageBER
0o 0o 1000
JGFF Specification TS 25101 (2000-12) Section 7.6
Specification requirements Test results
The DTCH and DECH BER shall not exceed 0.001 Passed

according to TS 25101

Blocking Characteristics Test Results

Intermodulation Characteristics

Intermodulation characteristics (defined in section 7.8 of TS25.101 [4]) are tested when MeasType is set to Intermod.

Test conditions are:

Parameter
DPCH_Ec
Tor
Iouwl (CW)
ITouw2 (modulated)
Fuwl (offset)

Fuw2 (offset)

In the RF channel, there are two intermodulation response signals that have a specific frequency relationship to the

Unit
dBm/3.84MHz
dBm/3.84MHz
dBm
dBm/3.84MHz
MHz

MHz
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requisite signal:

By default, the continuous wave interference has a +10 MHz frequency offset from the central carrier frequency;

its power is -46 dBm.
By default, the modulated interfering signal has a +20 MHz offset from the central carrier frequency; its power is

-46 dBm/3.84 MHz.

The following figure shows the intermodulation characteristics test results.

reallRF_FSourcel1 MHZ) reallRF_R) realilor _Power_dBm)
2740000 =0.00a -T035.700
reallMeas_FMeasurement)i1 MHZ) resl(Meas_R) DPCH_Ec_dBm
2740000 =0.000 -T14.000
EbMO_RF_db
TOESS
Meas BER Results
DTCH_AverageaBER DCCH_AverageBER DPCH_AverageBER
(.00 0,000 (.00

3GPP Specification TS 25,101 (2000-12) Section 7.8

Specification requirements Test results

The DTCH and DCCH BER shall not exceed 0,001
according to TS 25.101 Passed

Intermodulation Characteristics Test Results

Test Bench Variables for Data Displays

The following table identifies the reference variables used to set up this test bench.

Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display

Data Display Parameter Equation with Test Bench Parameters
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Spec_Version SpecVersion

RF_FSource FSource

RF_R SourceR

RF_SourceTemp SourceTemp

Ior_Power_dBm 30 + 10 log(Ior_Power), where Ior_Power =

RefLevel_Ior_Power, or MaxLevel_lor_Power, or
ACS_Ior_Power, or Blocking_Ior_Power, or
Intermod_Ior_Power, according to MeasType setting.

DPCH_Ec_2_Ior_dB RefLevel _DPCH_Ec_2_1Ior, or MaxLevel_DPCH_Ec_2_1Ior,
or ACS_DPCH_Ec_2_TIor, or Blocking_DPCH_Ec_2_Ior, or
Intermod_DPCH_Ec_2_Ior, according to MeasType

setting.
ChipRate 3.84MChips/Second
SlotTime 0.667ms
FrameTime 10ms
TimeStep 1/(3.84e6*SamplesPerChip)
Meas_FMeasurement FMeasurement
Meas_R MeasR
FrameNum FrameSetsMeasured * 4
ModFreq FSource + ModFreqOffset, Where ModFreqOffset =

ACS_ModFreqOffset, or Blocking_ModFreqOffset, or
Intermod_ModFreqOffset, according to MeasType setting
= ACS, Blocking, or Intermod.

ModePower_dBm 30 + 10 log (ModPower), where ModPower =
ACS_ModPower, or Blocking_ModPower or
Intermod_ModPower, according to MeasType setting =
ACS, Blocking, or Intermod.

CWFreq FSource + Intermod_CW_FreqOffset, valid when
MeasType = Intermod

CWPower_dBm 30 + 10 log(Intermod_CW_Power), valid when MeasType
= Intermod

Baseline Performance

e Test Computer Configuration
° Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
e Conditions
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° Measurements made with default test bench settings.

° RF DUT is an RF system behavior component.

° The number of time points in one slot can be calculated by SamplesPerChip times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
1 FrameSet = 4 Frames
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 p time points per slot = 20480

e Simulation times and memory requirements.

Measurement FrameSets Measured Simulation Time (sec) ADS Processes (MB)
RefLevel 21 6273 121
MaxLevel 21 6148 100
ACS 21 6819 102
Blocking 21 6935 103
Intermod 21 7655 103

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and the RF DUT Circuit Envelope
simulation with the same signal and number of time points. For example, if the RF DUT performance with Circuit
Envelope simulation alone takes 2 hours and consumes 200 MB of memory (excluding the memory consumed by the
core ADS product), then add these numbers to the Baseline Performance numbers to determine the expected ADS
performance. This is valid only if the full memory consumed is from RAM. If RAM is less, larger simulation times may
result due to increased disk access time for swap memory usage.

References
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2. 3GPP Technical Specification TS 25.212, "Multiplexing and Channel Coding (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25212-390.zi

3. 3GPP Technical Specification TS 25.213, "Spreading and modulation (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25213-370.zi

4. 3GPP Technical Specification TS 25.101, "UE Radio transmission and reception (FDD)" Release 1999.
http://www.3 .org/ftp/Specs/2002-03/R1999/25 series/25101-3a0.zi
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Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation documentation explains how to use
test bench windows and dialogs to perform analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation documentation explains how to set
up circuit envelope analysis parameters such as convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench Simulation documentation to learn how
to improve simulation speed.

RF DUT Limitations for 3GPP FDD Wireless Test Benches

This appendix describes test bench use with typical RF DUTs, improving test bench performance when certain RF DUT
types are used, and improving simulation fidelity. Two sections regarding special attention for Spectum and EVM
transmission measurements is also included.

The RF DUT, in general, may be a circuit design with any combination and quantity of analog and RF components,
transistors, resistors, capacitors, etc. suitable for simulation with the Agilent Circuit Envelope simulator. More complex
RF circuits will take more time to simulate and will consume more memory.

Test bench simulation time and memory requirements can be considered to be the combination of the requirements
for the baseline test bench measurement with the simplest RF circuit plus the requirements for a Circuit Envelope
simulation for the RF DUT of interest.

An RF DUT connected to a wireless test bench can generally be used with the test bench to perform default
measurements by setting the test bench Required Parameters. Default measurement parameter settings can be used
(exceptions described below), for a typical RF DUT that:

e Requires an input (RF) signal with constant RF carrier frequency.

The test bench RF signal source output does not produce an RF signal whose RF carrier frequency varies with
time. However, the test bench will support an output (RF) signal that contains RF carrier phase and frequency
modulation as can be represented with suitable I and Q envelope variations on a constant RF carrier frequency.

e Produces an output (Meas) signal with constant RF carrier frequency.

The test bench input (Meas) signal must not contain a carrier frequency whose frequency varies with time.
However, the test bench will support an input (Meas) signal that contains RF carrier phase noise or contains time
varying Doppler shifts of the RF carrier. These signal perturbations are expected to be represented with suitable I
and Q envelope variations on a constant RF carrier frequency.

¢ Requires an input (RF) signal from a signal generator with a 50-ohm source resistance. Otherwise, set the
SourceR parameter value in the Basic Parameters tab.

e Requires an input (RF) signal with no additive thermal noise (TX test benches) or source resistor temperature set
to 16.85 o C (RX test benches). Otherwise, set the SourceTemp (TX and RX test benches) and
EnableSourceNoise (TX test benches) parameters in the Basic Parameters tab.

e Requires an input (RF) signal with no spectrum mirroring. Otherwise, set the MirrorSourceSpectrum parameter
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value in the Basic Parameters tab.

e Produces an output (Meas) signal that requires a 50-ohm external load resistance. Otherwise, set the MeasR
parameter value in the Basic Parameters tab.

e Produces an output (Meas) signal with no spectrum mirroring. Otherwise, set the MirrorMeasSpectrum parameter
value in the Basic Parameters tab.

e Relies on the test bench for any measurement-related bandpass signal filtering of the RF DUT output (Meas)
signal.

° When the RF DUT contains a bandpass filter with bandwidth that is on the order of the test bench receiver
system (~1 times the test bench receiver bandwidth) and the user wants a complete characterization of the
RF DUT filter, the default time CE_TimeStep must be set smaller.

° When the RF DUT bandpass filter is much wider than the test bench receiver system (>2 times the test
bench receiver bandwidth), the user may not want to use the smaller CE_TimeStep time step to fully
characterize it because the user knows the RF DUT bandpass filter has little or no effect in the modulation
bandwidth in this case.

Improving Test Bench Performance

This section provides information regarding improving test bench performance when certain RF DUT types are used.

¢ Analog/RF models (TimeDelay and all transmission line models) used with Circuit Envelope simulation that
perform linear interpolation on time domain waveforms for modeling time delay characteristics that are not an
integer number of CE_TimeStep units. Degradation is likely in some measurements, especially EVM.

This limitation is due to the linear interpolation between two successive simulation time points, which degrades
waveform quality and adversely affects EVM measurements.

To avoid this kind of simulator-induced waveform quality degradation: avoid use of Analog/RF models that rely
on linear interpolation on time domain characteristics; or, reduce the test bench CE_TimeStep time step by a
factor of 4 below the default CE_TimeStep (simulation time will be 4 times longer).

e Analog/RF lumped components (R, L, C) used to provide bandpass filtering with a bandwidth as small as the
wireless signal RF information bandwidth are likely to cause degradation in some measurements, especially
Spectrum. These circuit filters require much smaller CE_TimeStep values than would otherwise be required for
RF DUT circuits with broader bandwidths.

This limitation is due to the smaller Circuit Envelope simulation time steps required to resolve the differential
equations for the L, C components when narrow RF bandwidths are involved. Larger time steps degrade the
resolution of the simulated bandpass filtering effects and do not result in accurate frequency domain
measurements, especially Spectrum and EVM measurements (when the wireless technology is sensitive to
frequency domain distortions).

To determine that your lumped component bandwidth filter requires smaller CE_TimeStep, first characterize your
filter with Harmonic Balance simulations over the modulation bandwidth of interest centered at the carrier
frequency of interest. Though it is difficult to identify an exact guideline on the Circuit Envelope time step
required for good filter resolution, a reasonable rule is to set the CE_TimeStep to 1/(double-sided 3dB
bandwidth)/32.

To avoid this kind of simulator-induced waveform quality degradation, avoid the use of R, L, C lumped filters with
bandwidths as narrow as the RF signal information bandwidth, or reduce the CE_TimeStep.

¢ Analog/RF data-based models (such as S-parameters and noise parameters in S2P data files) used to provide RF
bandpass filtering with a bandwidth as small as 1.5 times the wireless signal RF information bandwidth are likely
to cause degradation in some measurements, especially EVM.
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This limitation is due to causal S-parameter data about the signal carrier frequency requiring a sufficient number
of frequency points within the modulation bandwidth; otherwise, the simulated data may cause degraded signal
waveform quality. In general, there should be more than 20 frequency points in the modulation bandwidth; more
is required if the filter that the S-parameter data represents has fine-grain variations at small frequency steps.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use of data-based models with
bandwidths as narrow as the RF signal information bandwidth, or increase the number of frequency points in the
data file within the modulation bandwidth and possibly also reduce the CE_TimeStep simulation time step.

e An additional limitation exists when noise data is included in the data file. Circuit Envelope simulation technology
does not provide frequency-dependent noise within the modulation bandwidth for this specific case when noise is
from a frequency domain data file. This may result in output noise power that is larger than expected; if the
noise power is large enough, it may cause degraded signal waveform quality.

To avoid this kind of simulator-induced waveform quality degradation avoid the use of noise data in the
data-based models or use an alternate noise model.

Improving Simulation Fidelity

Some RF circuits will provide better Circuit Envelope simulation fidelity if the CE_TimeStep is reduced.

e In general, the default setting of the test bench SamplesPerChip provides adequate wireless signal definition and
provides the WTB_TimeStep default value.
e Set CE_TimeStep = 1/(3.84e6/SamplesPerChipxN)

where N is an integer > 1

e When CE_TimeStep is less than the WTB_TimeStep (i.e., N>1), the RF signal to the RF DUT is automatically
upsampled from the WTB_TimeStep and the RF DUT output signal is automatically downsampled back to the
WTB_TimeStep. This sampling introduces a time delay to the RF DUT of 10xWTB_TimeStep and a time delay of
the measured RF DUT output signal of 20xWTB_TimeStep relative to the measured RF signal sent to the RF DUT
prior to its upsampling.

Special Attention for Spectrum Measurements

The Spectrum Measurement spectrum may have a mask against which the spectrum must be lower in order to pass
the wireless specification. The Spectrum measurement itself is based on DSP algorithms that result in as much as 15
dB low-level spectrum variation at frequencies far from the carrier.

To reduce this low-level spectrum variation, a moving average can be applied to the spectrum using the
moving_average(<data>, 20) measurement expression for a 20-point moving average. This will give a better

indication of whether the measured signal meets the low-level spectrum mask specification at frequencies far from the
carrier.
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Special Attention for EVM Measurements

For the EVM measurement, the user can specify a start time. The EVM for the initial wireless segment may be
unusually high (due to signal startup transient effects or other reasons) that cause a mis-detected first frame that the

user does not want included in the RF DUT EVM measurement.

To remove the degraded initial burst EVM values from the RF DUT EVM measurement, set the EVM_Start to a value
greater than or equal to the RF DUT time delay characteristic.

Measurement Results for Expressions for 3GPP FDD
Wireless Test Benches

Measurement results from a wireless test bench have associated names that can be used in Expressions. Those
expressions can further be used in specifying goals for Optimization and Monte Carlo/Yield analysis. For details on

using expressions, see the Measurement Expressions documentation. For details on setting analysis goals using

Optimization and Monte Carlo/Yield analysis, see the Tuning, Optimization, and Statistical Design documentation.

You can use an expression to determine the measurement result independent variable name and its minimum and
maximum values. The following example expressions show how to obtain these measurement details where

MeasResults is the name of the measurement result of interest:

e The Independent Variable Name for this measurement result is obtained by using the expression

i ndep(MeasResul t s)
e The Minimum Independent Variable Value for this measurement result is obtained by using the expression

m n(i ndep( MeasResul ts))
e The Maximum Independent Variable Value for this measurement result is obtained by using the expression

nmax(i ndep( MeasResul ts))

The following tables list the measurement result names and independent variable name for each test bench
measurement. Expressions defined in a MeasEqgn block must use the full Measurement Results Name listed.
Expressions used in the Data Display may omit the leading test bench name. You can also locate details on the
measurement result minimum and maximum independent variable values by

e Referring to the measurement parameter descriptions when they are available (not all measurement parameter

descriptions identify these minimum and maximum values).
e Observing the minimum and maximum independent variable values in the Data Display for the measurement.

3GPPFDD_BS_TX Measurement Results

135


http://edocs.soco.agilent.com/display/ads2008/Measurement+Expressions
http://edocs.soco.agilent.com/display/ads2008/Tuning%2C+Optimization%2C+and+Statistical+Design

Advanced Design System 2008

Measurement Results Name

Independent Variable Name

Envelope

3GPPFDD_BS_TX.RF_V time
3GPPFDD_BS_TX.Meas_V time
Power

3GPPFDD_BS_TX.RF_Power.CCDF.CCDF Index
3GPPFDD_BS_TX.RF_Power.CCDF.MeanPower_dBm Index
3GPPFDD_BS_TX.RF_Power.CCDF.PeakPower_dBm Index
3GPPFDD_BS_TX.RF_Power.CCDF.SignalRange_dB Index
3GPPFDD_BS_TX.Meas_Power.CCDF.CCDF Index
3GPPFDD_BS_TX.Meas_Power.CCDF.MeanPower_dBm Index
3GPPFDD_BS_TX.Meas_Power.CCDF.PeakPower_dBm Index
3GPPFDD_BS_TX.Meas_Power.CCDF.SignalRange_dB Index
ACLR

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_L10 freq
3GPPFDD_BS_TX.RF_ACLR.Spec_Out_L5 freq
3GPPFDD_BS_TX.RF_ACLR.Spec_Out_Main freq
3GPPFDD_BS_TX.RF_ACLR.Spec_Out_U5 freq
3GPPFDD_BS_TX.RF_ACLR.Spec_Out_U10 freq
3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_L10 freq
3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_L5 freq
3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_Main freq
3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_U5 freq
3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_U10 freq
Occupied Bandwidth

3GPPFDD_BS_TX.RF_OBW.Spec_Out freq
3GPPFDD_BS_TX.Meas_OBW.Spec_Out freq

CDP

3GPPFDD_BS_TX.RF_CDP.CodeDomainPwr.CDP_Codelnde

kKIndex

rIndex

3GPPFDD_BS_TX.RF_CDP.CodeDomainPwr.CodeDomainPWw
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3GPPFDD_BS_TX.Meas_CDP.CodeDomainPwr.CDP_Codelndimdex

3GPPFDD_BS_TX.Meas_CDP.CodeDomainPwr.CodeDomairjPindex

PCDE

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.CDE_COdeIndJ)IndeX

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.I_CDE Index

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.Q_CDE Index

3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.CDE_Codeljdagex

3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.I_CDE Index
3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.Q_CDE Index
EVM
3GPPFDD_BS_TX.RF_EVM.EVM.EVM Index
3GPPFDD_BS_TX.Meas_EVM.EVM.EVM Index
3GPPFDD_UE_TX Measurement Results

Measurement Results Name Independent Variable Name
Envelope
3GPPFDD_UE_TX.RF_V time
3GPPFDD_UE_TX.Meas_V time
Power
3GPPFDD_UE_TX.RF_Power.CCDF.CCDF Index
3GPPFDD_UE_TX.RF_Power.CCDF.MeanPower_dBm Index
3GPPFDD_UE_TX.RF_Power.CCDF.PeakPower_dBm Index
3GPPFDD_UE_TX.RF_Power.CCDF.SignalRange_dB Index
3GPPFDD_UE_TX.Meas_Power.CCDF.CCDF Index
3GPPFDD_UE_TX.Meas_Power.CCDF.MeanPower_dBm Index
3GPPFDD_UE_TX.Meas_Power.CCDF.PeakPower_dBm Index
3GPPFDD_UE_TX.Meas_Power.CCDF.SignalRange_dB Index
ACLR
3GPPFDD_UE_TX.RF_ACLR.Spec_Out_L10 freq
3GPPFDD_UE_TX.RF_ACLR.Spec_Out_L5 freq
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3GPPFDD_UE_TX.RF_ACLR.Spec_Out_Main freq
3GPPFDD_UE_TX.RF_ACLR.Spec_Out_U5 freq
3GPPFDD_UE_TX.RF_ACLR.Spec_Out_U10 freq
3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_L10 freq
3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_L5 freq
3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_Main freq
3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_U5 freq
3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_U10 freq

ACLR_SwitchingTransients

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L10.Averd

deBkackPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L10.Avera

detietalPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L5.Averad

dBldbekPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L5.Averad

dhatetPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.Main.Avej

lagettbockPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.Main.Avej

loelEotalPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients. U5.Avera(|1éBdimkPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients. U5.Averal|éﬁdtad Power

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U10.Aver

geBéockPower

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U10.Aver

dedekalPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L10.Av

bfageRlockPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L10.Av

bfageXotalPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L5.Ave

dgeBlockPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L5.Ave

dgdEatalPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.Main.A

énalgeBlockPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.Main.A

énaigaTotalPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U5.Avg

FagedkockPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U5.Avg

FégedwotalPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U10.AV

chadeBlockPower

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U10.AV

FhageX otalPower

Occupied Bandwidth
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3GPPFDD_UE_TX.RF_OccupiedBW.Spec_Out

freq

3GPPFDD_UE_TX.Meas_OccupiedBW.Spec_Out

freq

CDP

3GPPFDD_UE_TX.RF_CDP.CodeDomainPwr.CDP_Codelnde

kKIndex

3GPPFDD_UE_TX.RF_CDP.CodeDomainPwr.CodeDomainPW

fMndex

3GPPFDD_UE_TX.Meas_CDP.CodeDomainPwr.CDP_Codeln

Hdex

3GPPFDD_UE_TX.Meas_CDP.CodeDomainPwr.CodeDomair]Pdeex

PCDE

3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.CDE_CodelndgxXndex
3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.I_CDE Index
3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.Q_CDE Index

3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.CDE_Codelfjdarex

3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.I_CDE Index
3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.Q_CDE Index
EVM

3GPPFDD_UE_TX.RF_EVM.EVM.EVM Index
3GPPFDD_UE_TX.Meas_EVM.EVM.EVM Index
3GPPFDD_BS_RX Measurement Results

Measurement Results Name Independent Variable Name

3GPPFDD_BS_RX.Meas_BER.DCCHbits Index
3GPPFDD_BS_RX.Meas_BER.DCCH_BER Index
3GPPFDD_BS_RX.Meas_BER.DCCH_BLER Index
3GPPFDD_BS_RX.Meas_BER.DPDCHbits Index
3GPPFDD_BS_RX.Meas_BER.DPDCH_BER Index
3GPPFDD_BS_RX.Meas_BER.DTCHbits Index
3GPPFDD_BS_RX.Meas_BER.DTCH_BER Index
3GPPFDD_BS_RX.Meas_BER.DTCH_BLER Index
3GPPFDD_BS_RX.Meas_BER.RefDCCHbits Index
3GPPFDD_BS_RX.Meas_BER.RefDPDCHbits Index
3GPPFDD_BS_RX.Meas_BER.RefDTCHbits Index
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3GPPFDD_UE_RX Measurement Results

Measurement Results Name
3GPPFDD_UE_RX.Meas_Measurement.DCCHbits
3GPPFDD_UE_RX.Meas_Measurement.DCCH_BER
3GPPFDD_UE_RX.Meas_Measurement.DCCH_BLER
3GPPFDD_UE_RX.Meas_Measurement.DPCHbits
3GPPFDD_UE_RX.Meas_Measurement.DPCH_BER
3GPPFDD_UE_RX.Meas_Measurement.DTCHbits
3GPPFDD_UE_RX.Meas_Measurement.DTCH_BER
3GPPFDD_UE_RX.Meas_Measurement.DTCH_BLER
3GPPFDD_UE_RX.Meas_Measurement.RefDCCHbits
3GPPFDD_UE_RX.Meas_Measurement.RefDPCHbits

3GPPFDD_UE_RX.Meas_Measurement.RefDTCHbits

Index
Index
Index
Index
Index
Index
Index
Index
Index
Index

Index
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